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Sicherheitstechnische Hinweise 

Dieses Handbuch enthält Hinweise, die Sie zu Ihrer persönlichen Sicherheit sowie zur Vermeidung von 
Sachschäden beachten müssen. Die Hinweise sind durch ein Warndreieck hervorgehoben und je nach 
Gefährdungsgrad folgendermaßen dargestellt: 
 

!  
Gefahr 
bedeutet, dass Tod, schwere Körperverletzung oder erheblicher Sachschaden eintreten werden, 
wenn die entsprechenden Vorsichtsmaßnahmen nicht getroffen werden. 
 

!  
Warnung 
bedeutet, dass Tod, schwere Körperverletzung oder erheblicher Sachschaden eintreten können, 
wenn die entsprechenden Vorsichtsmaßnahmen nicht getroffen werden. 
 

!  
Vorsicht 
bedeutet, dass eine leichte Körperverletzung oder ein Sachschaden eintreten können, wenn die 
entsprechenden Vorsichtsmaßnahmen nicht getroffen werden. 
 

 Vorsicht 
bedeutet, dass ein Sachschaden eintreten kann, wenn die entsprechenden Vorsichtsmaßnahmen 
nicht getroffen werden. 
 

 Achtung 
ist eine wichtige Information über das Produkt, die Handhabung des Produktes oder den jeweiligen 
Teil der Dokumentation, auf den besonders aufmerksam gemacht werden soll. 
 

Qualifiziertes Personal 
Inbetriebsetzung und Betrieb eines Gerätes dürfen nur von qualifiziertem Personal vorgenommen 
werden. Qualifiziertes Personal im Sinne der sicherheitstechnischen Hinweise dieses Handbuchs sind 
Personen, die Berechtigung haben, Geräte, Systeme und Stromkreise gemäß den Standards der 
Sicherheitstechnik in Betrieb zu nehmen, zu erden und zu kennzeichnen. 

Bestimmungsgemäßer Gebrauch 

Beachten Sie Folgendes: 
 

!  
Warnung 
Das Gerät darf nur für die im Katalog und in der technischen Beschreibung vorgesehenen Einsatzfälle 
und nur in Verbindung mit von Siemens empfohlenen bzw. zugelassenen Fremdgeräten und -
komponenten verwendet werden. 
Der einwandfreie und sichere Betrieb des Produktes setzt sachgemäßen Transport, sachgemäße 
Lagerung, Aufstellung und Montage sowie sorgfältige Bedienung und Instandhaltung voraus. 

Marken 
SIMATIC®, SIMATIC HMI® und SIMATIC NET® sind Marken der Siemens AG. 

Die übrigen Bezeichnungen in dieser Schrift können Marken sein, deren Benutzung durch Dritte für 
deren Zwecke die Rechte der Inhaber verletzen kann. 
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Wichtige Hinweise 

Zweck des Handbuchs 

 

Dieses Handbuch bietet dem Leser einen vollständigen Überblick über die 
Safety Matrix-Anwendung.  

Dieses Handbuch wendet sich an Programmierer von Safety Matrix-
Programmen und an alle Personen, die für Projektierung, Inbetriebnahme und 
Wartung von Automatisierungssystemen verantwortlich sind.  

 

Erforderliche Grundkenntnisse 

 

Allgemeine Kenntnisse auf dem Gebiet der Automatisierungstechnik sind 
Voraussetzung zum Verständnis dieses Handbuch.  

Darüber hinaus sollte der Leser mit der Arbeit an Rechnern oder Geräten mit 
ähnlichen Funktionen (z.B. Programmiergeräten) mit Windows-
Betriebssystemen vertraut sein.  

  

Gültigkeitsbereich des Handbuchs 

Dieses Handbuch betrifft das Softwarepaket SIMATIC Safety Matrix V5.2. 

 

 

Normen, Zertifikate und Zulassungen 

Safety Matrix ist zertifiziert für den Einsatz im Sicherheitsbetrieb bis: 

• Anforderungsklasse AK1 bis AK6 nach DIN V 19250/DIN V VDE 

• Sicherheitsanforderungsklasse (Safety Integrity Level) SIL1 bis SIL3 nach 
IEC 61508 

• Kategorie 1 bis 4 nach EN 954-1 
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Weitere Unterstützung 

Bei Fragen zur Nutzung der im Handbuch beschriebenen Produkte, die Sie hier 
nicht beantwortet finden, wenden Sie sich bitte an Ihren Siemens-
Ansprechpartner in den für Sie zuständigen Vertretungen und Geschäftsstellen. 

Ihren Ansprechpartner finden Sie unter: 

http://www.siemens.com/automation/partner 

Den Wegweiser zum Angebot an technischen Dokumentationen für die 
einzelnen SIMATIC Produkte und Systeme finden Sie unter: 

http://www.siemens.de/simatic-tech-doku-portal 

Den Online-Katalog und das Online-Bestellsystem finden Sie unter: 

http://mall.de.siemens.com/ 

Trainingscenter  
Um Ihnen den Einstieg in das xxxx  und das Automatisierungssytem S7 zu 
erleichtern, bieten wir entsprechende Kurse an. Wenden Sie sich bitte an Ihr 
regionales Trainingscenter oder an das zentrale Trainingscenter in 
D 90327 Nürnberg.  

Telefon:  +49 (911) 895-3200.  

Internet: http://www.sitrain.com 

http://www.siemens.com/automation/partner
http://www.siemens.de/simatic-tech-doku-portal
http://mall.de.siemens.com/
http://www.sitrain.com
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A&D Technical Support 
 

Weltweit erreichbar zu jeder Tageszeit:  

Peking 

 Nürnberg 

Johnson City 

 

 Weltweit (Nürnberg) 

Technical Support  

 

Ortszeit: 0:00 bis 24:00 / 365 Tage 

Telefon: +49 (180) 5050-222 

Fax: +49 (180) 5050-223 

mailto:adsupport@siemens.com 

GMT: +1:00 

  

Europa / Afrika (Nürnberg) 

Authorization 

 

Ortszeit: Mo.-Fr. 8:00 bis 17:00 

Telefon: +49 (180) 5050-222 

Fax: +49 (180) 5050-223 

mailto:adsupport@siemens.com 

GMT: +1:00 

United States (Johnson City) 

Technical Support and 
Authorization 

Ortszeit: Mo.-Fr. 8:00 bis 17:00 

Telefon: +1 (423) 262 2522 

Fax: +1 (423) 262 2289 

mailto:simatic.hotline@sea.siemens.com 

GMT: -5:00 

Asien / Australien (Peking) 

Technical Support and 
Authorization 

Ortszeit: Mo.-Fr. 8:00 bis 17:00 

Telefon: +86 10 64 75 75 75 

Fax: +86 10 64 74 74 74 

mailto:adsupport.asia@siemens.com 

GMT: +8:00 

Technical Support und Authorization sprechen generell Deutsch und Englisch. 

 

mailto:adsupport@siemens.com
mailto:adsupport@siemens.com
mailto:simatic.hotline@sea.siemens.com
mailto:adsupport.asia@siemens.com
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Service & Support im Internet 

Zusätzlich zu unserem Dokumentationsangebot bieten wir Ihnen unseren 
Online-Support im Internet unter: 

http://www.siemens.com/automation/service&support 

Dort finden Sie: 

• den Newsletter, der Sie ständig mit den aktuellsten Informationen zu Ihren 
Produkten versorgt 

• die für Sie richtigen Dokumente über unsere Suche in Service & Support 

• ein Forum, in welchem Anwender und Spezialisten weltweit Erfahrungen 
austauschen 

• Ihren Ansprechpartner für Automation & Drives vor Ort über unsere 
Ansprechpartner-Datenbank 

• Informationen über Vor-Ort-Service, Reparaturen, Ersatzteile und vieles 
mehr unter dem Begriff "Leistungen". 

http://www.siemens.com/automation/service&support
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1 Einführung in Safety Matrix 

Safety Matrix ist ein Toolkit, mit dem der Zeitaufwand für das Projektieren, Testen 
und die Wartung verringert wird, indem die früher getrennten Schritte der 
Erstellung einer Ursachen-Wirkungs-Matrix und der Projektierung eines 
Sicherheitssystems zusammengeführt werden.  Es ist sowohl ein Tool als auch 
eine Methodik.  

 

1.1 Methodik der Ursachen-Wirkungs-Matrix 

Die Methodik der Ursachen-Wirkungs-Matrix wird benutzt, um festzulegen, wie und 
wann Schalthandlungen in einem Sicherheitssystem ausgeführt werden. Bei dieser 
Methodik werden Prozessereignisse Ursachen- und Wirkungskategorien 
zugeordnet und diese Ursachen und Wirkungen dann miteinander verknüpft. Die 
Verknüpfungen zwischen Ursachen und Wirkungen werden als Schnittpunkte 
bezeichnet, die zeigen, welche Wirkung eine bestehende Ursache haben wird. Aus 
diesen Daten kann eine Programmlogik für die Abarbeitung bestimmter 
Ablaufschritte entwickelt werden, mit denen Ereignisse kontrolliert bzw. verhindert 
werden können, bevor sie Schäden im Prozess anrichten können.  
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1.2 Safety Matrix - Übersicht 

Die Safety-Matrix-Software vereinfacht die Erstellung einer Ursachen-Wirkungs-
Matrix durch die Bereitstellung einer fertigen Vorlage für die Dateneingabe. Die 
Matrix enthält drei Datenfelder: Ursachen, Wirkungen und Schnittpunkte.  

 

 
Nummer Feld  Beschreibung 

1 Ursache Eine Ursache belegt eine Zeile der Matrix. Diese Feld entspricht einer 
Prozessabweichung.  Sobald die Ursachen-Tags bestimmte 
benutzerdefinierte Bedingungen erfüllen, wird das Feld aktiv. 

2 Wirkung Eine Wirkung belegt eine Spalte der Matrix. Dieses Feld entspricht einer 
Prozesshandlung.  Ist die Wirkung aktiv, so werden die Wirkungs-Tags auf 
ihre fehlersicheren Werte gesetzt. 

3 Schnittpunkt Ein Schnittpunkt ist die gemeinsame Zelle zwischen einer Ursachenzeile und 
einer Wirkungsspalte. Dieses Feld legt fest, wie die Wirkung zur Ursache in 
Beziehung steht.  Ist das Schnittpunktfeld leer, so beeinflusst die Ursache die 
Wirkung nicht.  Steht ein N (not stored), S (set stored), V (override) oder R 
(resetable Override) im Schnittpunkt, so verursacht eine aktive Ursache die 
zugehörige Wirkung und die Wirkung wird aktiv. 
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1.2.1 Beschreibung der Matrix – Kurzübersicht 

1. Projektieren: Projektieren der gewünschten Ursachen und Wirkungen und 
Verknüpfung mit Hilfe der Schnittpunkte.  

2. Übersetzen/Laden: Ist die Ursache-Wirkungs-Logik in Ordnung, so kann die 
Matrix gespeichert und in ein SIMATIC-Projekt übertragen werden.  
Die Ursache-Wirkungs-Logik wird als Plan-im-Plan innerhalb eines CFC-Plans 
übertragen und kann in dieser Form übersetzt und letztlich in ein AS oder 
einen Simulator übertragen werden.  

Der CFC-Plan enthält die gesamte Logik für die Abarbeitung der Matrix, die 
Ereignisaufzeichnung und die Matrix-Sicherheit. 

3. Überwachen: Die Safety-Matrix-Software konsolidiert die Echtzeit-
Eingangsdaten zu allen Verriegelungen und liefert dynamische, graphische 
Darstellungen zu einer oder mehreren laufenden Matrices.  

4. Wartung: Nach der Erstellung einer Matrix kann sie benutzt werden, um 
Umgehungsfunktionen für Wartungszwecke, Rücksetz- und Override-
Funktionen einzurichten.  Alle Aktionen werden automatisch im 
Ereignisprotokoll der Matrix aufgezeichnet.  Zusätzlich zur eigentlichen Aktion 
werden in diesem Protokoll Datum, Uhrzeit, Benutzername und Grund für die 
Aktion hinterlegt, so dass man über eine umfassende Änderungshistorie 
verfügt. 
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1.3 Betriebsart 

Das Safety Matrix Programming Tool kann in zwei verschiedenen Betriebsarten 
benutzt werden, nämlich: 

• Offline-Betrieb Entwickeln einer Ursache-Wirkungs-Matrix, die eine 
Sicherheitsfunktion beschreibt. Der Offline-Betrieb unterstützt ferner das 
Übersetzen von Projekten und das Laden der Matrix. 

• Überwachungsbetrieb Anzeige von Echtzeitwerten und 
Zustandsüberwachung der Matrix. 

Eine Matrix sollte im Offline-Betrieb angelegt und im Überwachungsbetrieb mit 
dem PLC Simulator getestet werden, bevor sie in ein System geladen wird. 

 
 Hinweis 

Sichern Sie vor der Bearbeitung eine Kopie jeder Matrix, damit eine vollständige 
Änderungsübersicht vorhanden ist. 
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1.4 Produktübersicht 

Die SIMATIC Safety Matrix Produktlinie besteht aus drei Hauptkomponenten: 

• dem Safety Matrix Engineering Tool 

• dem Safety Matrix Viewer 

• dem Safety Matrix Editor 

Diese Komponenten unterstützen verschiedene Funktionen in Planung und 
Funktion der Ursachen-Wirkungs-Logik. 

 
Safety Matrix Engineering 
Tool 

Enthält das komplette Paket mit Tools zum Anlegen, Projektieren, 
Übersetzen und Laden von Matrices in eine SIMATIC STEP 7 Engineering 
Station (ES) Umgebung. Zusätzlich unterstützt es die Kommunikation mit 
einer Laufzeitsteuerung zum Testen der Matrixlogik. 

Safety Matrix Viewer Unterstützt Matrices in der PCS 7 Operating Station (OS) einer PCS 7 
WinCC-Umgebung. Der Safety Matrix Viewer zeigt die Laufzeit-Matrixlogik in 
der Steuerung in einem Format, das mit dem des Safety Matrix Engineering 
Tools kompatibel ist. Mehrere Bedienebenen der Matrix-Funktionalität sind 
durch OS-Benutzerrechte geschützt. 

Safety Matrix Editor Ermöglicht das Anlegen und Überprüfen der Matrixlogik in der entfernten 
Workstation, ohne dass SIMATIC STEP 7 oder eine PCS 7-Umgebung 
erforderlich sind. Die mit dem Safety Matrix Editor entwickelten oder 
bearbeiteten Matrices können bequem per e-mail verschickt oder auf andere 
Weise mit einem Benutzer des Safety Matrix Engineering Tools für die 
Einbindung in ein SIMATIC-Projekt gemeinsam genutzt werden. 

  

Safety
Matrix
Editor

Remote User Workstation

Shared Matrix File
(* .CEM)

Safety Matrix
Viewer

Operator Station (OS)

Safety Matrix
Engineering

Tool

Engineering Station (ES)

Controller (AS)
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2 Richtlinien für sicherheitskritische 
Funktionen 

Wenn das Safety Matrix Optionspaket für sicherheitskritische Funktionen 
verwendet wird, gelten die folgenden Anweisungen: 

1. Safety Matrix ist ein Optionspaket für S7 F/FH Systems. Der Benutzer muss 
alle Sicherheitshinweise im Systemhandbuch „SIMATIC 
Automatisierungssysteme S7 F/FH Systems" lesen, verstehen und beachten.  

2. Die Sicherheitszertifizierung gilt nur für Safety Matrix ab Version 5.2.0.0.  

3. Zur Validierung und Überprüfung der Matrix-Logik ist Abschnitt „Matrix 
Projektdienste" in diesem Dokument zu beachten. 

4. PLCSim kann für die endgültige Überprüfung der Safety Matrix Logik nicht 
benutzt werden. Verwenden Sie PLCSim für die Kontrolle und Fehlerbehebung 
in der Logik vor dem Laden in einem CPU. Die Validierung und Überprüfung 
der Safety Matrix Logik ist nur in einem realem System möglich.  

5. Die E/A-Baugruppen erzeugen Informationen über die Datenqualität. Diese 
Qualitätsinformationen können von der Safety Matrix Logik gelesen und 
verarbeitet werden. Die Qualitätsinformationen werden beim Lesen den Daten 
zugeordnet, nicht mit dem Logikergebnis weitergegeben. Der Benutzer kann 
Ursache-Optionen für die Auslösung bei mangelhafter Qualität projektieren, 
wenn eine Reaktion auf schlechte Datenqualität erforderlich ist. 

6. Der Safety Matrix Überwachungsbetrieb ist keine sicherheitskritische 
Komponente und nicht im Rahmen der Sicherheitsfunktion zu verwenden. Alle 
Sicherheitsreaktionen müssen in der CPU-logik hinterlegt sein. 

7. Die Ein- und Ausgangskanalkonfiguration sollte mit der Richtung der 
Ursachen-Wirkungskonfiguration der Safety Matrix für Energize-to-trip 
(Auslösen bei Wahr) oder De-energize-to-trip (Auslösen bei Falsch) 
übereinstimmen. De-energize-to-trip ist die Standardeinstellung. 

8. Online-Änderungen von Überwachungsbefehlen müssen durch Prüfen der 
Rückmeldewerte kontrolliert werden. 

9. Zum TÜV-Zertifkat für die fehlersicheren Komponenten der S7 F/FH Systeme, 
siehe Abschnitt 4.1.3 mit weiteren Anweisungen für Online-Änderungen (siehe 
auch die TÜV-Website: <www.tuv-fs.com>). 

10. Vor dem Einsatz der Safety Matrix für sicherheitskritische Anwendungen sind 
die aktuellen Versionen der folgenden Zertifizierungsunterlagen für die 
Funktionssicherheit zu beachten: 

- TÜV-Zertifikat für die fehlersicheren Komponenten der S7 F/FH Systeme 

- Anhang 1 des TÜV-Zertifikats für die fehlersicheren Komponenten der S7 
F/FH Systeme 
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- Anhang 3 des TÜV-Zertifikats für die fehlersicheren Komponenten der S7 
F/FH Systeme 

11. Die forgenden Funktionen müssen gemäß den TÜV 
„Wartungseingriffsrichtlinien" durchgeführt werden: 

- Forcen 

- Wertänderungen  

- Wartungseingriffe  

Diese Änderungen liegen vollständig in der Verantwortung des Betreibers. 

Das TÜV Zertifikat verbietet das Forcen von Ausgängen. 
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3 Getting Started 

3.1 Hardware-Voraussetzungen 

Für den Betrieb der Safety Matrix Software ist die folgende Hardware erforderlich: 

• PC mit CD-ROM-Laufwerk 

• F-System-Hardwarekomponenten: 

- S7 F/FH System CPU (z.B. CPU  417-4  H) mit einer F-Kopierlizenz 

- Fehlersichere Signalbaugruppen (F-SM) 

3.2 Software-Voraussetzungen 

Für den Betrieb der Safety Matrix-Komponenten mit ihrem gesamten 
Funktionsumfang ist die folgende Software erforderlich: 

Allgemeine Anforderungen 
• Internet Explorer V6.0, SP1 oder höher 

Safety Matrix Engineering Tool 
• S7 F-Systems V5.2 oder höher  

• S7 F Lib V1.2 oder höher 

• STEP 7 V5.2 oder höher 

• CFC V6.0 oder höher 

• Windows 2000 Professional, SP3 oder höher, oder Windows XP Professional 

Safety Matrix Viewer 
• PCS 7 OS V6.0 SP2 oder höher 

• Windows 2000 Professional, SP3 oder höher 

Safety Matrix Editor 
• Windows 2000 Professional, SP3 oder höher, oder Windows XP Professional 
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3.3 Installation 

Die SIMATIC Safety Matrix für S7 F-Systemkomponenten wird von der Safety 
Matrix Installations-CD wie folgt installiert: 

1. Legen Sie die Safety Matrix Installations-CD ins CD-Laufwerk Ihres PCs ein. 

2. Wählen Sie im Windows Start-Menü Option Ausführen und geben Sie im 
Dialogfeld AUSFÜHREN die Zeichenfolge E:\setup.exe ein (ggf. an Stelle von 
E den Buchstaben Ihres CD-ROM-Laufwerks einsetzen). Klicken Sie auf OK.  
Sie können das Setup-Programm auch durch Doppelklick auf das Symbol 
Ihres CD-ROM-Laufwerks im Dialogfeld Mein Computer und Markieren des 
Setup-Symbols im Programmordner starten. 

3. Folgen Sie den Anweisungen des Setup-Programms und wählen Sie die 
gewünschten Safety Matrix-Komponenten aus. 

4. Installieren Sie die erforderlichen Laufzeit-Lizenzen für Safety Matrix 
Engineering Tool, Safety Matrix Viewer und Safety Matrix Editor. 

 
 Hinweis 

Die Sprachauswahl ist nur für die Hilfedatei und das Benutzerhandbuch möglich. Sie beruht 
auf der STEP 7 Sprachauswahl (falls installiert) oder der Spracheinrichtung in Windows. 
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4 Konfiguration 

4.1 Anlegen einer neuen Safety Matrix 

In einem SIMATIC-Projekt ist die Ursachen-Wirkungs-Logik in einem Matrix-Objekt 
hinterlegt, in dem die Logik eingerichtet und in Form eines Funktionsbausteins in 
einem CFC-Plan übertragen wird. Jedes Matrix-Objekt unterstützt bis zu 128 
Ursachen und 128 Wirkungen mit maximal 500 Schnittpunkten. Eine Steuerung 
kann mehrere Matrices im Rahmen ihrer Speicherkapazität unterstützen. 

Hinzufügen eines Matrix-Objekts in einem Projekt 
1. Öffnen Sie das Projekt im SIMATIC Manager. 

2. Gehen Sie im Projekt zum S7 Programmordner. 
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3. Klicken Sie mit der rechten Maustaste auf den S7 Programmordner und 
wählen Sie Neues Objekt einfügen>Ordner Matrix.  Ein neuer Matrix-Ordner 
wird im S7-Programm angelegt. 
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4. Klicken Sie mit der rechten Maustaste auf Ordner Matrix und wählen Sie 
Neues Objekt einfügen>Matrix 

 
 
 

5. Geben Sie einen Namen (bis zu 16 Zeichen) für das Matrix-Objekt ein.  
 
  

 Hinweis 
Das Kopieren/Einfügen von Safety Matrix-Bausteinen ist nicht ratsam. Dadurch 
geht die Verbindung zwischen dem SIMATIC-Projekt und dem Safety Matrix 
Engineering Tool verloren und das Programm funktioniert nicht ordnungsgemäß.  
Um eine Matrix zu kopieren, speichern Sie eine bestehende Matrix mit dem Safety 
Matrix Engineering Tool unter einem anderen Namen ab.  
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4.2 Projektieren der Safety Matrix 

Projektieren einer neuen Safety Matrix 
Doppelklick auf das Matrix-Objekt im SIMATIC Manager.  Das Safety Matrix 
Engineering Tool wird geöffnet wie nachstehend gezeigt.  
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4.3 Ursachen hinzufügen und bearbeiten 

4.3.1 Ursache hinzufügen 

1. Doppelklicken Sie auf eine beliebige Stelle im Ursachenteil einer leeren Zeile. 
Enthält die Matrix keine leeren Zeilen, so können sie durch Vergrößern der 
Matrix Zeilen hinzufügen.  

2. Zum Vergrößern der Matrix klicken Sie auf View>Options. Das Dialogfeld mit 
den Matrixoptionen wird aufgeblendet. 

3. Geben Sie in Feld Number of Causes die gewünschte Zahl ein. Zulässige 
Werte für die Matrix sind 16-128.   

 

 
 Hinweis 

Durch Klick mit der rechten Maustaste in einer vorhandenen Ursachenzeile kann 
mit Befehl Insert Row eine leere Ursache in die Matrix eingefügt werden.  Enthält 
die Matrix keine leeren Zeilen, so wird durch das Einfügen einer leeren Zeile die 
letzte Zeile der Matrix entfernt (gelöscht).  Vor dem Einfügen von Zeilen mit Befehl 
Insert Row ist die Matrix mit Hilfe des Dialogfeldes zu vergrößern. 
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4.3.2 Ursache bearbeiten 

Doppelklicken Sie auf eine beliebige Zelle im Ursachenteil einer Zeile.  Dialogfeld 
Configuration for Cause # wird aufgeblendet. In dieses Dialogfeld gelangt man 
auch durch Anklicken einer Ursache mit der rechten Maustaste und Markieren von 
Edit Cause im Popup-Menü. 
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4.4 Ursache - Registerkarte Configure 

 

 
Feld Beschreibung 

Cause Number Dies ist eine einmalige Nummer, die jeder Ursache zugeordnet ist.  Die 
Zuordnung erfolgt automatisch auf Grund der ausgewählten Zeile.  Die 
Ursachennummer kann in diesem Dialogfeld nicht geändert werden. 
 

Desc (Description) Alphanumerische Beschreibung der Ursache. Die Eingabe einer 
Beschreibung ist obligatorisch, sie kann bis zu 32 Zeichen lang sein. 
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Feld Beschreibung 

Tag # Symbolische Namen der im SIMATIC-Projekt konfigurierten Eingänge für den 
jeweiligen Eingangstyp. Zulässige Ursachen-Tags sind I/O und interne 
Variable.  
• Analoge und/oder diskrete Eingangs-Tags – Mit Klick auf Schaltfläche I/O 

wird Dialogfeld Select I/O Tag geöffnet. Dialogfeld Select I/O Tag enthält 
eine Liste der als Eingangs-Tags verwendbaren Symbole. 

• Externe Eingänge - Sie sind mit einem vorangestellten "#" 
gekennzeichnet und veranlassen das Anlegen einer Eingangsknotens im 
Matrix CFC-Plan für die Verschaltung mit der Benutzerlogik. 

Die Eingabe in diesem Feld ist obligatorisch. 
Das Safety Matrix Engineering Tool platziert während der Übertragung in 
einen CFC-Plan automatisch die Tag-Kanaltreiber.  
Soll ein Kanaltreiber mit zusätzlicher Logik außerhalb der Matrix verschaltet 
werden, so ist dem projektierten Tag ein "#" anzufügen. Das Safety Matrix 
Engineering Tool verbindet den Kanaltreiber mit einem Ausgang des CFC-
Plans, der dann so verschaltet werden kann als wäre er der Kanaltreiber. 
Wurde der Tag bereits von einer anderen Matrix oder Benutzerlogik 
projektiert, so führt die übertragene Matrix eine Verschaltung mit dem 
vorhandenen Kanaltreiber aus. Eine solche Verschaltung mit einem 
vorhandenen Treiber wird vom Safety Matrix Engineering Tool mit einem 
vorangestellten "@" im Projektierungsfeld des Tags gekennzeichnet. 
 

Energize-To-Trip Inputs 
(Trip on True) 

Dies ist eine Option für diskrete Eingangstypen und legt fest, welcher 
Boole'sche Zustand eine unsichere Bedingung (Auslösung) darstellt. In De-
energize-To-Trip -Anwendungen stellt der Ursachen-Tag eine unsichere 
Bedingung (Auslösung) dar, wenn er nach OFF (FALSCH) wechselt.  In De-
energize-To-Trip-Anwendungen stellt der Ursachen-Tag eine unsichere 
Bedingung (Auslösung) dar, wenn er nach ON (WAHR) wechselt). 
Standardmäßig ist dieses Kontrollkästchen nicht aktiviert (De-energize-To-
Trip). 
 

Safety Integrity Level 
(SIL) 

Ein SIL-Wert ist eine Bewertung des Schweregrades eines gefährlichen 
Ereignisses und der Wahrscheinlichkeit seines Auftretens.   
Es gibt verschiedene Verfahren zu Bestimmung des SIL-Wertes.  Für die 
Zuordnung von SIL-Werten können beispielsweise die Normen ISA S84 und 
IEC 61508 benutzt werden.  Die Eingabe eines SIL-Wertes in die Matrix ist 
jedoch nicht zwingend erforderlich und dient nur zu Dokumentationszwecken.  
In der Standardeinstellung ist kein SIL-Wert eingegeben. 
 

Input Type Es muss zu jeder Ursache ein Eingangstyp gewählt werden. 

 
• Discrete Der diskrete Typ ist ein Boole'scher Wert (WAHR/FALSCH). Er wird 

beispielsweise für Endschalter oder Motorkontrollsignale benutzt.  Diskret ist 
die Standardeinstellung für den Eingangstyp. 
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Feld Beschreibung 

• Analog Ein analoger Eingang stellt einen realen Wert dar, z.B. den Wert eines 
Temperaturgebers oder eine Durchflussmenge.  Wird analog als Eingangstyp 
gewählt, so müssen die Eingangsparameter entsprechend eingestellt werden.  
Die Parametereinstellung erfolgt in Registerkarte Analog Parameters im 
Dialogfeld Configuration for Cause #. 
 

Number of Inputs Angabe, wie viele Eingänge einer bestimmten Ursache zugeordnet sind. 
Werden beispielsweise drei Geber für die Überwachung ein- und desselben 
Prozesspunktes benutzt, so ist ein Wert 3 auszuwählen.  
 

Function Type Der Funktionstyp gibt an, unter welchen Bedingungen eine Ursache aktiv 
wird. Die Eingabe in diesem Feld ist obligatorisch.  
Hinweis: Der Funktionstyp führt zu einem Auslösebefehl. Der Auslösebefehl 
kann zeitverzögert sein, bevor die Ursache aktiv wird, er kann gesperrt 
und/oder umgangen werden. 

 
Funktionstyp Anzahl der 

Eingänge 
Beschreibung 

Normal 1 Eine Durchgangsfunktion.  Ist der Ursachen-Tag in einem 
unsicheren Zustand, so gilt die Ursache als aktiv. 
 

Majority Vote 3 Sind zwei der drei Ursachen-Tags im unsicheren Zustand, so gilt 
die Ursache als aktiv. 
 

AND 2 oder 3 Alle Ursachen-Tags müssen im unsicheren Zustand sein, damit 
die Ursache als aktiv gilt. 
 

OR  2 oder 3 Ist mindestens ein Ursachen-Tag im unsicheren Zustand, so gilt 
die Ursache als aktiv. 
 

For Note Only 1, 2, oder 3 Die Ursache wird nicht verarbeitet.  Nur zu 
Dokumentationszwecken. 
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4.5 Ursache - Registerkarte Analog Parameters  

 

 
Einstellungen Beschreibung 

Limit Value Der in diesem Feld eingegebene Wert bedeutet, dass der Ursachen-Tag in einer 
unsicheren Bedingung ist, wenn der Tag-Wert kleiner, größer oder gleich diesem 
Eingabewert - je nach dem ausgewählten Grenzwerttyp - ist. 
 

Limit Type Diese Einstellung legt fest, ob der Grenzwert ein oberer oder ein unterer Grenzwert ist. 
Ist es ein oberer Grenzwert, so ist der Ursachen-Tag in einer unsicheren Bedingung, 
wenn sein Wert größer oder gleich dem Eingabewert im Feld Limit Value ist.  Ist es ein 
unterer Grenzwert, so ist der Ursachen-Tag in einer unsicheren Bedingung, wenn sein 
Wert kleiner oder gleich dem Eingabewert im Feld Limit Value ist. 
 



 Konfiguration 

Safety Matrix Benutzerhandbuch 
A5E00265324-01 4-11 

Einstellungen Beschreibung 

Hysteresis Die Hysterese legt eine Totzone im Bereich des Grenzwertes fest, wenn ein Ursachen-
Tag die unsichere Bedingung verlässt.  So wird verhindert, dass ein Eingang ständig 
zwischen sicher und unsicher pendelt. In der Standardeinstellung ist keine Hysterese 
eingestellt, das entspricht einem Wert 0. 
Beispiele: 
Ist für die Ursache ein oberer Grenzwert von 90,0 und eine Hysterese von 5,0 
eingestellt, so bleibt die Ursache aktiv, bis der Wert unter 85,0 fällt.   
Ist für die Ursache ein unterer Grenzwert von 10,0 und eine Hysterese von 2,0 
eingestellt, so bleibt die Ursache aktiv, bis der Wert über 12,0 steigt. 
 

Delta Diese Eingabe gilt nur für analoge Eingänge mit mehr als einem Ursachen-Tag. Es wird 
ein Diagnosealarm ausgelöst, wenn die Ursachen-Tags sich mindestens um den 
eingegebenen Delta-Wert unterscheiden. Zum Löschen eines Diagnosealarms müssen 
diese Werte innerhalb des Deltabereichs minus der Hysterese liegen.  
Beispiel: Ist ein Deltawert von 5,0 und eine Hysterese von 2,0 eingestellt, so wird ein 
Diagnosealarm angezeigt, wenn die Werte sich um 5,0 oder mehr unterscheiden. Die 
Werte müssen in einem Bereich von 3,0 liegen, damit der Diagnosealarm gelöscht wird.  
In der Standardeinstellung ist kein Deltawert eingegeben.  Wird für Delta nichts oder ein 
Wert 0 eingegeben, so erfolgt keine Berechnung für Delta minus Hysterese.  
Für andere Funktionstypen wird ein Diagnosealarm ausgelöst, wenn die Ursachen-Tags 
sich mindestens um den eingegebenen Delta-Wert unterscheiden. Zum Löschen eines 
Diagnosealarms müssen diese Werte auch wieder innerhalb des Deltabereichs minus 
der Hysterese liegen. 
 

Eng Units Gibt die technischen Einheiten (engineering units) des Analogwertes an.  Dieser Wert 
kann bis zu acht Zeichen lang sein und dient lediglich zu Dokumentationszwecken. 
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4.6 Ursache - Registerkarte Options  

 

 
Einstellung Beschreibung 

Time Die Ursachen können so konfiguriert werden, dass die nachstehend 
beschriebenen Zeitfunktionen berücksichtigt werden.  Nähere Einzelheiten 
sind dem Zeitablaufdiagramm zu entnehmen.  
 

• None Mit diesem Kontrollkästchen werden alle Zeitoptionen zu dieser Ursache 
gelöscht. None ist die Standardeinstellung. 
 

• PreTrip Delay Damit wird eine Einschaltverzögerung eingestellt.  Der/die Ursachen-Tag(s) 
muss/müssen mindestens während der eingestellten Zeitdauer im unsicheren 
Zustand sein, bevor die Ursache aktiv wird. 
 

• PostTrip Delay Damit wird eine Ausschaltverzögerung eingestellt.  Der/die Ursachen-Tag(s) 
muss/müssen mindestens während der eingestellten Zeitdauer im sicheren 
Zustand sein, bevor die Ursache inaktiv wird. 
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Einstellung Beschreibung 

• Timed Cause Ist zu einer Ursache diese Option gewählt, so bleibt die Ursache während der 
in Feld Duration eingegebenen Zeit aktiv, unabhängig davon, ob die 
Auslösebedingung der Ursache die ganze Zeit WAHR bleibt oder nicht. 
 

• Duration Gilt nur für die Einstellungen PreTrip Delay, PostTrip Delay und Timed 
Cause. Die Zeitdauer wird in Sekunden angegeben und kann kann jeden 
beliebigen ganzzahligen Wert bis 255, außer Null, annehmen. 
 

Bypass Tag Die Ursachen können so konfiguriert werden, dass die folgenden 
Umgehungsfunktionen möglich sind: 
 

• "Soft" Bypass 
Allowed 

Ist Kontrollkästchen "Soft" Bypass Allowed aktiviert, so kann der Bediener für 
Wartungszwecke im Überwachungsbetrieb eine Umgehung im Safety Matrix 
Viewer oder Safety Matrix Engineering Tool anlegen.  Für eine Software-
Umgehung muss der Benutzer über die entsprechenden Zugriffsrechte 
verfügen. In der Standardeinstellung ist dieses Kontrollkästchen aktiv. 
 

• Bypass Tag Im Eingabefeld Bypass Tag kann ein Boole'scher Tag eingegeben werden.  
Für die Ursache wird eine Umgehung aktiv, wenn der Wert des Umgehungs-
Tags WAHR ist. Eine Umgehung wird in der Regel für Wartungszwecke 
angelegt. 
 

Process Inhibit Tag Die Funktion Process Inhibit wird typischerweise benutzt, um eine Ursache 
während des automatischen Anfahrens in einem Batch-Prozess automatisch 
zu unterdrücken.   
 
Der Process Inhibit-Tag ist ein Boole'scher Tag.  Die Ursache wird 
unterdrückt, wenn der Inhibit-Tag WAHR ist.  
 

First Out Alarm Group Im Überwachungsbetrieb zeigt die First Out Alarm-Funktion an, welche 
Ursache zuerst aktiv geworden ist (d.h. die Auslösung veranlasst hat).  Die 
Ursache, die in jeder Gruppe zuerst ausgelöst hat, wird farblich 
hervorgehoben dargestellt. Eine Ursache kann in jede beliebige der 15 
verschiedenen First-Out-Gruppen eingeordnet werden. Die First Out Alarm-
Funktion ist in der Standardeinstellung ausgeschaltet. Um eine Ursache in 
einer First Out Alarm-Gruppe hinzuzufügen, ist einfach die Gruppennummer 
im Textfeld des Optionsdialogs einzugeben. 
 

Anmerkungen Es können zu jeder Matrix 31 Anmerkungen eingegeben werden.  In den 
Auswahlfeldern Notes können jeder Wirkung bis zu vier Anmerkungen 
zugeordnet werden.  Die Zahlen im Kästchen neben jedem Auswahlfeld Note 
beziehen sich auf die zugehörige Anmerkung, wenn diese im Safety Matrix 
Programming Tool enthalten ist. 
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Einstellung Beschreibung 

Safety Instrumented 
Function (SIF) 
Gruppierung 

Eine Ursache kann bis zu vier Sicherheitsgruppen zugeordnet sein. Eine SIF-
Gruppe enthält zusammengehörige Ursachen und Wirkungen, die 
typischerweise einer einzigen Sicherheitsschaltung aus Gebern, AS und den 
Steuerungselementen, die eine bestimmte Sicherheitsfunktion ausführen, 
zugeordnet sind.  Mit der Zuordnung zu einer SIF-Gruppe sind 
Filterfunktionen für die Anzeige im Überwachungsbetrieb für Ursachen & 
Wirkungen verbunden. 
 

Auto Acknowledge Active 
Cause 

Ist Kontrollkästchen Auto Acknowledge Active Cause aktiviert, so wird die 
Ursache automatisch gelöscht, sobald die Ursachen-Tags wieder in den 
sicheren Zustand zurückkehren.  Ist dieses Kontrollkästchen nicht aktiviert, so 
muss der Bediener das Löschen einer aktiven Ursache manuell veranlassen.  
In der Standardeinstellung ist dieses Kontrollkästchen aktiv. 
 

Input Trip on Tag Quality Ist Input Trip on Tag Quality aktiviert, so bewirken die von den Kanaltreibern 
gemeldeten Qualitätsfehler, dass der Eingang zwangsweise den ausgelösten 
Zustand anzeigt. 
 

Enable Any Input Trip 
Alarm 

Ist eine Ursache mit mehreren Eingängen projektiert, so kann der Benutzer 
wählen, ob ein Alarm angezeigt wird, wenn einer der Eingänge die 
Auslösekriterien erfüllt. Standardmäßig sind diskrete und analoge Eingänge 
wie unten beschrieben eingerichtet: 
• Diskret standardmäßig ausgeschaltet 
• Analog standardmäßig eingeschaltet 

 

Zeitablaufdiagramm für Ursache-Zeitfunktionen 

Normal Cause
(no time function)

Cause Active

Pre-Trip Delay Cause configured duration

Cause
Active

Post Trip Delay Cause configured duration

Cause Active

Timed Cause configured duration

Cause Active
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4.7 Wirkungen hinzufügen und bearbeiten 

4.7.1 Wirkung hinzufügen 

1. Doppelklicken Sie auf eine beliebige Stelle im Wirkungsteil einer leeren Spalte. 
Enthält die Matrix keine leeren Spalten, so können sie durch Vergrößern der 
Matrix Spalten hinzufügen.   

2. Zum Vergrößern der Matrix klicken Sie auf View>Options. Das Dialogfeld mit 
den Matrixoptionen wird aufgeblendet. 

3. Geben Sie in Feld Number of Effects die gewünschte Zahl ein.  Die maximale 
Matrixgröße beträgt 128 x 128.  

 

 
 Hinweis 

Mit Insert Column im Menü Edit kann eine leere Wirkungsspalte in die Matrix 
eingefügt werden.  Enthält die Matrix keine leeren Spalten, so wird durch das 
Einfügen einer zusätzlichen Wirkungsspalte die letzte Spalte der Matrix entfernt 
(gelöscht).  Vor dem Einfügen von Spalten mit Befehl Insert Column ist die Matrix 
mit Hilfe des Dialogfeldes Select Display Options zu vergrößern. 
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4.7.2 Wirkung bearbeiten 

1. Doppelklicken Sie auf eine beliebige Zelle im Wirkungsteil einer Spalte.  
Dialogfeld Configuration for Effect # wird aufgeblendet.  In dieses Dialogfeld 
gelangt man auch durch Anklicken einer Wirkung mit der rechten Maustaste 
und Markieren von Edit Effect im Popup-Menü. 

2. Beim Hinzufügen oder Bearbeiten einer Wirkung muss eine 
Wirkungsbeschreibung eingegeben und mindestens ein Tag angegeben 
werden. 

3. Nach Eingabe der Tags sind die Wirkungsoptionen für alle Tagtypen zu prüfen 
und entsprechend einzustellen. 
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4.8 Wirkung - Registerkarte Configure 

 

 
Feld Beschreibung 

Effect Number Dies ist eine einmalige Nummer, die jeder Wirkung zugeordnet ist.  Die 
Zuordnung erfolgt automatisch auf Grund der ausgewählten Spalte.  Die 
Wirkungsnummer kann in diesem Dialogfeld nicht geändert werden. 
 

Desc (Description) Alphanumerische Beschreibung der Wirkung, die bis zu 32 Zeichen lang sein 
kann.  Die Eingabe der Beschreibung ist obligatorisch. 
 

Safety Integrity Level 
SIL 

Ein SIL-Wert ist eine Bewertung des Schweregrades eines gefährlichen 
Ereignisses und der Wahrscheinlichkeit seines Auftretens.  
Es gibt verschiedene Verfahren zu Bestimmung des SIL-Wertes. Für die 
Zuordnung von SIL-Werten können beispielsweise die Normen ISA S84 und 
IEC 61508 benutzt werden.  Die Eingabe eines SIL-Wertes in die Matrix ist 
jedoch nicht zwingend erforderlich und dient nur zu Dokumentationszwecken.  
Standardmäßig ist kein SIL-Wert eingegeben. 
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Feld Beschreibung 

For Note Only Standardmäßig werden alle Wirkungen und bis zu vier Wirkungs-Tags auf die 
jeweiligen Werte gesetzt, wenn die Wirkung aktiv wird. Ist das Kontrollkästchen 
For Note Only markiert, so findet keine Aktion statt, wenn die Wirkung aktiv 
wird. 
 

Tag # Dies sind die Symbolnamen der diskreten Ausgänge, die im SIMATIC-Projekt 
eingerichtet sind. Zulässige Wirkungs-Tags sind I/O und interne Variable. 
• Diskrete Ausgangs-Tags – Mit Klick auf Schaltfläche I/O wird Dialogfeld 

Select I/O Tag geöffnet. Dialogfeld Select I/O Tag enthält eine Liste der als 
Ausgangs-Tags verwendbaren Symbole. 

• Externe Eingänge - Durch ein vorangestelltes "#" gekennzeichnet. Externe 
Ausgänge verursachen das Anlegen eines Ausgangsknotens auf dem 
Matrix CFC-Plan für die Verschaltung mit der Benutzerlogik. 

Die Eingabe in diesem Feld ist obligatorisch. 
Wurde der Tag bereits von einer anderen Matrix oder Benutzerlogik projektiert, 
so führt die übertragene Matrix eine Verschaltung mit dem vorhandenen 
Kanaltreiber aus. Eine solche Verschaltung mit einem vorhandenen Treiber wird 
vom Safety Matrix Engineering Tool mit einem vorangestellten "@" im 
Projektierungsfeld des Tags gekennzeichnet. 
 

Action  In dieses Feld ist ein Text mit acht Zeichen einzugeben, das beschreibt, welche 
Aktion veranlasst wird, wenn die Wirkung aktiv ist (zum Beispiel ÖFFNEN).  
Dieser Wert dient lediglich zur Anzeige/Dokumentation. 
 

Energize-To-Trip 
Output 

Ist dieses Kästchen markiert, so wird der Wirkungs-Tag erregt (WAHR), wenn 
die Wirkung aktiv ist. Der Wert eines Wirkungs-Tags ist normalerweise nicht 
erregt (auf FALSCH), wenn die Wirkung aktiv ist.  Wirkungs-Tags, für die 
Energize-To-Trip aktiviert ist, sind in der Safety Matrix mit einem Stern am 
Wirkungs-Tag gekennzeichnet.  In der Standardeinstellung ist dieses 
Kontrollkästchen nicht aktiv. 
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4.9 Wirkung - Registerkarte Options 

 

 
Feld  Beschreibung 

Output Delay Ist Kontrollkästchen Enabled aktiviert, so werden die Ausgänge nach einer 
gewissen Zeitverzögerung auf die fehlersicheren Wert gesetzt.  Die Länge 
der Zeitverzögerung in Sekunden wird durch den Wert in Eingabefeld Delay 
Output angegeben. Zum Löschen einer projektierten Zeitverzögerung muss 
der Wert in Delay Output auf Null gesetzt und Kontrollkästchen Enable 
Process Pass Through deaktiviert werden. 
 

Bypass Tag Die Wirkungen können so konfiguriert werden, dass die folgenden 
Umgehungsfunktionen möglich sind: 
 

"Soft" Bypass Allowed Ist Kontrollkästchen "Soft" Bypass Allowed aktiviert, so kann der Bediener 
für Wartungszwecke im Überwachungsbetrieb eine Umgehung im Safety 
Matrix Viewer oder Safety Matrix Engineering Tool anlegen.  Für eine 
Software-Umgehung muss der Benutzer über die entsprechenden 
Zugriffsrechte verfügen.  In der Standardeinstellung ist dieses 
Kontrollkästchen nicht aktiv.  
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Feld  Beschreibung 

Bypass Tag Im Eingabefeld Bypass Tag kann ein Boole'scher E/A-Tag ausgewählt bzw. 
eingegeben werden.  Für die Wirkung wird eine Umgehung aktiv, wenn der 
Wert des Umgehungs-Tags WAHR ist.  Eine Umgehung wird in der Regel 
für Wartungszwecke angelegt. 
 

Reset/Override Tag Die Wirkung kann mit Override übergangen werden, wenn 
Schnittpunkttypen V oder R verwendet werden, oder sie kann bei 
Verwendung der Schnittpunkttypen S oder R zurückgesetzt werden. Die 
Wirkung wird zurückgesetzt, wenn ein Tag einen FALSCH-WAHR-Übergang 
aufweist. Bei einem Override wird der Override-Status mit einem FALSCH-
WAHR-Übergang umgeschaltet. Siehe Kapitel Schnittpunkttypen mit 
näheren Einzelheiten. 
 

Maximum Override Time In diesem Eingabefeld kann der Benutzer die maximale Zeit in Sekunden 
eingeben, für die die Wirkung im Override-Zustand bleiben kann. Sind die 
Bedingungen, die die Wirkung ausgelöst haben, nach Ablauf der maximalen 
Override-Zeit immer noch vorhanden, so wird die Wirkung wieder aktiv und 
ein Alarm "OverrideFailed TimeOut" erscheint. Wird eine neue Ursache 
aktiv, die dieser Wirkung zugeordnet ist, so endet die Override-Funktion, die 
Wirkung wird wieder aktiv und ein Alarm "OverrideFailed NewCause" 
erscheint. 
Die mit Maximum Override Time projektierte Zeit sollte nicht größer 
als die Dauer jeder beliebigen Bedingung sein, die der Prozess oder 
die Anlage toleriert. 
 

Masking or Process Pass 
Through 

 
 

Enable Process Pass 
Through 

Dieses Kontrollkästchen zeigt an, dass eine Wirkung für einen 
Prozessdurchgang projektiert werden muss.  Die Projektierung einer 
Wirkung für den Prozessdurchgang setzt voraus, dass ein "Process Data 
Tag" angegeben ist. Siehe Beschreibung "Prozessdurchgang" weiter unten. 
 

Mask Enable Tag Der Wert des Mask Enable-Tags legt fest, ob die Wirkungslogik oder eine 
extern gesteuerte Prozessvariable (siehe "Prozessdaten-Tag") mit den 
Ausgangs-Tags der Wirkung verschaltet ist. Siehe Beschreibung 
"Maskieren" weiter unten.  
 

Process Data Tag Kennzeichnet eine externe Prozessvariable, die in den Ausgang der 
Wirkung geschrieben wird, wenn die Wirkung nicht aktiv ist.  Dadurch kann 
ein Ausgang von einem Prozesswert gesteuert werden, bis eine unsichere 
Bedingung die Wirkung aktiviert und veranlasst, dass die Wirkung in den 
projektierten sicheren Zustand geht.  Ist ein Mask Enable-Tag projektiert 
und freigeschaltet, wird dieser Wert immer in die Ausgangs-Tags 
geschrieben. Für diskrete Energize-To-Trip (ETT) Ausgangs-Tags wird der 
Wert für Process Data Tag invertiert, bevor er in die Ausgangs-Tags 
geschrieben wird. 
 



 Konfiguration 

Safety Matrix Benutzerhandbuch 
A5E00265324-01 4-21 

Feld  Beschreibung 

Safety Instrumented 
Function Grouping 

Eine Wirkung kann bis zu vier Sicherheitsgruppen zugeordnet sein. Eine 
SIF-Gruppe enthält zusammengehörige Ursachen und Wirkungen, die 
typischerweise einer einzigen Sicherheitsschaltung aus Gebern, AS und den 
Steuerungselementen, die eine bestimmte Sicherheitsfunktion ausführen, 
zugeordnet sind.  Die Zuordnung zu einer SIF-Gruppe bewirkt die Filterung 
der Anzeige von Ursachen & Wirkungen. 
 

Anmerkungen Es können zu jeder Matrix 31 Anmerkungen eingegeben werden.  In den 
Auswahlfeldern Notes können jeder Wirkung bis zu vier Anmerkungen 
zugeordnet werden. Die Zahlen im Kästchen neben jedem Auswahlfeld Note 
beziehen sich auf die zugehörige Anmerkung, wenn diese im Safety Matrix 
Programming Tool enthalten ist. 

 



Konfiguration 

 Safety Matrix Benutzerhandbuch 
4-22 A5E00265324-01 

Process Pass Through 
Dies ist ein Konzept, bei dem eine (von einem Steuerungssystem) extern 
gesteuerte Prozessvariable mit der Ausgangslogik der Wirkung verschaltet werden 
kann.  Der Prozessdurchgang wird von der Matrix ignoriert, wenn die Wirkung aktiv 
wird.  Ein Prozessdurchgang wird durch Markieren des Kontrollkästchens "Enable 
Process Pass Through" und Eingabe eines Prozessdaten-Tags für die 
Prozessvariable projektiert. 

 
 Hinweis 

Ist Option "Process Pass Through" aktiviert, so ist für "Mask Enable Tag" keine 
Eingabe zu projektieren.  

 

Der Durchgang wird durch den aktiven Zustand der Wirkung gesteuert, siehe 
nachfolgende Abbildung. Der Wert des Prozessdaten-Tags wird mit den 
Ausgangs-Tags verschaltet, wenn die Wirkungslogik nicht aktiv ist.  Wird die 
Wirkungslogik aktiv, so wird die Verschaltung des Prozessdaten-Tag-Wertes mit 
den Ausgangs-Tags der Wirkung gelöst und der Ausgang wird von den 
fehlersicheren Werten angesteuert.  Der fehlersichere Wert für einen De-energize-
To-Trip (DTT) Ausgang ist falsch und für einen Engergize-To-Trip (ETT) Ausgang 
ist er WAHR.  

Process  Data  Tag  value

Effect Failsafe
Value

Output Tags

Distributed Control System

Effect in-active
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Maskieren 
Durch Maskieren der Wirkung kann der Benutzer die Wirkungslogik mit dem 
Prozessdatenwert, wie unten gezeigt, übergehen (Override).Die Override-Funktion 
wird durch den Wert des Mask Enable-Tags gesteuert. 

 

Process  Data  Tag  value

Effect  Logic Output Tags

Distributed Control System

Mask Enable Tag = TRUE

 

Die Projektierung einer Wirkung für die Maskierung setzt voraus, dass für "Mask 
Enable Tag" und "Process Data Tag" Werte eingegeben sind.  Der Wert für "Mask 
Enable Tag" legt fest, ob die Wirkungslogik oder eine extern gesteuerte 
Prozessvariable (siehe "Process Data Tag") mit den Ausgangs-Tags der Wirkung 
verschaltet ist.   

 

Die Optionen "Masking" und "Process Pass Through" können bei der Projektierung 
einer Wirkung zusammen oder getrennt implementiert werden.  
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4.10 Hinzufügen und Bearbeiten von Schnittpunkten 

Schnittpunkt hinzufügen oder bearbeiten 
Wählen Sie eine gültige Schnittpunkt-Zelle. Eine gültige Zelle verbindet eine Zeile 
und eine Spalte mit einer projektierten Ursache und Wirkung.  Jede Matrix 
unterstützt bis zu 500 Schnittpunkte.  

 

Schnittpunkt öffnen 
Um Dialogfeld Intersection Type zu öffnen, ist wie folgt vorzugehen: 

• Doppelklick auf eine Schnittpunkt-Zelle. 

• Klick auf die Schnittpunkt-Zelle mit der rechten Maustaste und Auswahl von 
Edit Intersection im Popup-Menü. 
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4.11 Dialogfeld Intersection Type 

 

 
Feld Beschreibung 

N - Not-Stored Einfache Durchgangsfunktion.  Ist die Ursache aktiv, wird die Wirkung 
ausgelöst. 
 

S - Set-Stored Ist die Ursache aktiv, wird die Wirkung ausgelöst und gespeichert (verriegelt).  
Wird die Wirkung nicht mehr ausgelöst, so muss sie vom Bediener durch 
manuellen Eingriff oder durch Setzen des projektierten Reset/Override-Tags 
auf WAHR gelöscht werden. 
 

V - Override Ist die Ursache aktiv, wird die Wirkung ausgelöst.  Die Wirkung kann vom 
Bediener durch manuellen Eingriff oder durch Setzen des projektierten 
Reset/Override-Tags auf WAHR, solange die Wirkung noch ausgelöst wird, 
übergangen werden. Dies ermöglicht dem Benutzer die erneute Integration 
seines Systems, wenn der Wirkungsausgang eine Ursache im aktiven 
Zustand hält.  
 

R - Resetable Override Dieser Schnittpunkttyp ist eine Verbindung der oben beschriebenen Typen S 
und V.  Die mit diesem Schnittpunkt verschalteten Wirkungen bleiben 
verriegelt, wenn die zugehörige Ursache inaktiv wird, können jedoch mit der 
Override-Funktion übergangen werden. 
 

None Es besteht keine Verbindung zwischen dieser Ursache und dieser Wirkung 
(kein Eintrag im Schnittpunkt).  Dies ist der voreingestellte Schnittpunkttyp. 
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Feld Beschreibung 

X - Not Specified Es ist eine Verbindung zwischen der Ursache und der Wirkung erforderlich, 
aber der gewünschte Schnittpunkttyp ist noch nicht festgelegt.  Es wird keine 
Verbindung verarbeitet, bis der Schnittpunkttyp eingegeben ist.  Eine Matrix 
mit Schnittpunkttyp X kann nicht an die Steuerung übertragen werden 
 

* - For Note Only Es wird keine Verbindung zwischen dieser Ursache und dieser Wirkung 
verarbeitet. Nur zu Dokumentationszwecken. 
 

XooN – Specify X___(2-
15) 

Damit können Ursachen nach dem Mehrheitsverfahren zugeordnet werden.  
X wird vom Benutzer eingegeben, N wird bestimmt anhand der Anzahl der 
Schnittpunkte mit X als Koeffizienten.   
Zu jeder Wirkung ist nur eine XooN-Zuordnung zulässig.  Es können für die 
Zuordnung nach dem Mehrheitsprinzip nur Schnittpunkte gleichen Typs (zum 
Beispiel alle S oder alle N) berücksichtigt werden.  Beispiele für diese Art der  
Schnittpunktzuordnung zeigt die folgende Abbildung. 
 

Beispiele für die Schnittstellenzuordnung nach dem Mehrheitsprinzip 

 

 
 Hinweis 

Safety Matrix bietet ein bequemes Verfahren für die Sammelverarbeitung der 
Sicherheitslogik. Der Benutzer kann zum Beispiel eine Möglichkeit suchen, um alle 
Wirkungen der Matrix gleichzeitig zu aktivieren. Dies ist möglich, indem eine einzige 
Ursache projektiert und durch einen Schnittpunkt mit allen Wirkungen verschaltet wird. Wird 
diese Ursache aktiv, so löst sie jede Wirkungslogik aus (einschließlich projektierter 
Zeitverzögerungen). 
Um die Steuerungsausgänge auf ihre fehlersicheren Werte zu setzen, kann eine Wirkung 
eingefügt werden, die mit der Abschaltlogik der Steuerung verschaltet ist. 
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4.12 Bearbeiten allgemeiner Informationen 

Das Safety Matrix Engineering Tool unterstützt die Dokumentation allgemeiner 
Informationen für jede Matrix. 

Das Dialogfeld General Information wird mit  View>General Information geöffnet. 
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Feld Beschreibung 

Title Geben Sie einen Titel zur Bezeichnung der Matrix ein 
 

Project Geben Sie ggf. den Titel des Projekts ein, zu dem die Matrix gehört.  
 

Description Geben Sie eine prozessbezogene Beschreibung der Matrix ein.  
 

General Notes Geben Sie allgemeine Anmerkungen zu dieser speziellen Matrix ein.  
 

User Notes Dies sind Anmerkungen, die mit bestimmten Ursachen und/oder 
Wirkungen verknüpft werden können. Es können bis zu 31 
Anmerkungen eingegeben werden.  Zu jeder Ursache und Wirkung 
können maximal vier Anmerkungen erfasst werden. Jede Anmerkung 
darf bis zu 60 Zeichen enthalten. 
 

Major Revisions Dropdown-Anzeigefeld mit einer Übersicht der größeren Änderungen. 
 

Safety Instrumented Function 
Groups 

Hier kann eine Beschreibung der Ursachen und Wirkungen 
eingegeben werden, die mit einer bestimmten Sicherheitsschleife oder 
der gewünschten Ansicht verbunden sind. In Safety Matrix Engineering 
Tool und Safety Matrix Viewer kann die Anzeige dann so gefiltert 
werden, dass nur die jeweils relevanten Safety Instrumented Function 
Groups angezeigt werden. Diese Funktion ist vom Benutzer 
projektierbar. 
 

Matrix Cycle Time (ms) Damit kann die Zykluszeit der Steuerung, in die die Matrix übertragen 
wird, festgelegt werden. Mit dem Dropdown-Menü kann die 
gewünschte Zeit aus den vorhandenen Auswahlmöglichkeiten (alle in 
ms) ausgewählt werden. Diese Zykluszeiten gehören zu den 
Ausführungszeiten von OB 30 bis 38. 
Hinweis 
Wie bei der herkömmlichen S7F Systemprogrammierung können 
Kanaltreiber aus einem anderen OB verwendet werden. Zum 
Verschalten mit einem Kanaltreiber in einem anderen OB sind externe 
Eingänge für die Matrix anzulegen und mit RTG-RTG-Kommunikation 
zu arbeiten. 
 

Statistics Zeigt Basisinformationen über die Anzahl der in der Matrix projektierten 
Elemente an. 
 

Major Revision  
• Next Major Rev 

- Revision 
- TimeStamp 

Mit dieser Schaltfläche können größere Änderungen hochgeschaltet 
werden.  Die Nummer und Datum/Uhrzeit der Änderung werden in 
Dialogfeld General Information angezeigt.  Wird eine größere 
Änderung vorgenommen, so werden Sie aufgefordert, einen 
Kommentar zur Beschreibung der Änderung einzugeben. 
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Minor Revision  
• Next Minor Rev 

- Revision 
- TimeStamp 

Mit dieser Schaltfläche können kleinere Änderungen hochgeschaltet 
werden. Die Nummer und Datum/Uhrzeit der Änderung werden in 
Dialogfeld General Information angezeigt. Beim Hochschalten der 
Nummer der größeren Änderung wird die Nummer der kleineren 
Änderung auf Null zurückgesetzt. 
Bei jeder Speicherung der Matrix werden Sie aufgefordert, die Nummer 
für kleine Änderungen hochzuschalten. 
 

Matrix File Revision 
- Revision 
- TimeStamp 

Änderungsnummer und Datum/Uhrzeit der zuletzt gespeicherten 
Matrixdatei.  
 

Path to Matrix File Gibt den Dateipfad an, in dem die Konfigurationsdatei der Matrix 
gespeichert ist.. 
 

Path to SIMATIC Project Kennzeichnet das SIMATIC-Projekt, mit dem die Matrix verknüpft ist. 
 

Logical Path to S7 Program Bezeichnet den Pfad zur Matrix in SIMATIC Component View. 
 

Matrix in Plant Hierarchy Bezeichnet den Pfad zur Matrix in SIMATIC Plant View. 
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4.13 Matrix Projektdienste 

Nach der vollständigen Projektierung von Safety Matrix muss die Matrix 
gespeichert und an das Projekt übertragen werden, bevor sie übersetzt und zur 
Ausführung in die SPS geladen wird.  

Übertragen der Matrix an ein Projekt 
1. Wählen Sie Tools->Project Utilities. 

 

 

2. Wählen Sie Transfer Changes To Project. Die Übertragung der Matrix an das 
Sicherheitsprogramm des Projekts ist passwortgeschützt. Geben Sie das 
Passwort für das Sicherheitsprogramm ein, sobald die entsprechende 
Aufforderung erscheint. 

 

Während der Übertragung überprüft das Safety Matrix Engineering Tool die 
Matrix auf Projektierungsalarme wie etwa Ursachen ohne Schnittpunkte oder 
Wirkungen ohne Reset-Tags und Fehler wie mehrere Wirkungen mit dem 
gleichen Ausgangs-Tag. Die Ergebnisse der Überprüfungsberichte werden im 
Log-Fenster angezeigt. 
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3. Ist die Überprüfung in Ordnung, so führt das Safety Matrix Engineering Tool 
einen Vergleich zwischen der aktuellen Matrix und der im Projekt 
gespeicherten Matrix durch. Die Unterschiede werden im Log-Fenster 
angezeigt. Der Benutzer wird aufgefordert, die Änderungen zu überprüfen, 
bevor die Übertragung fortgesetzt wird. 

Bei der Übertragung wird im SIMATIC-Projekt ein Plan mit dem gleichen 
Namen wie die Matrix angelegt. Der Plan enthält einen gesperrten Teil 
(@MatrixName ) mit der vollständigen Konfiguration der Matrix. Ein zweiter 
Planteil (MatrixName) enthält die automatischen Verschaltungen mit den 
Kanaltreibern. 

Der Kanaltreiberplan hat zwei Eingänge. Eingang ACK_REI ist mit allen 
internen Kanaltreibereingängen ACK_REI verschaltet. Dieser Eingang kann 
vom Kunden nicht verändert werden. Im Safety Matrix Plan wird ACK_REI 
nach Empfang des Befehls vom Safety Matrix Engineering Tool ausgegeben. 

Eingang PASS_ON ist mit allen internen Kanaltreibereingängen PASS_ON 
verschaltet. Er kann vom Kunden verändert werden. 

Der Kanaltreiberplan hat nur einen Ausgang. Ausgang ACK_REQ ist ein 
Boole'scher Wert, der durch Veroderung aller ACK_REQ-
Kanaltreiberausgänge erzeugt wird. Damit wird angezeigt, dass mindestens 
einer der Kanaltreiber eine erneute Integration erfordert. Die ACK-Anforderung 
wird an den Safety Matrix Plan, das Safety Matrix Engineering Tool und den 
Safety Matrix Viewer weitergeleitet. 

In einer typischen Konfiguration hat der Safety Matrix Plan nur einen Eingang, 
nämlich ACK_REQ, der vom ACK_REQ-Ausgang des Kanaltreiberplans 
angesteuert wird. 

Dem Kunden stehen fünf Ausgänge zur Verfügung: 

- Error – Boole'scher Merker, der anzeigt, dass ein Konfigurationsfehler 
erkannt wurde. 

- Alarm – Boole'scher Merker, der anzeigt, dass eine Alarmbedingung 
erkannt wurde. 

- Any_CA – Zeigt an, dass mindestens eine der Ursachen in der Matrix aktiv 
ist. 

- Any_EA – Zeigt an, dass mindestens eine der Wirkungen in der Matrix 
aktiv ist. 

- CByp_Num – Ganzzahliger Wert, der anzeigt, wie viele Ursachen aktuell 
mit Umgehung geschaltet sind. 

- EByp_Num – Ganzzahliger Wert, der anzeigt, wie viele Wirkungen aktuell 
mit Umgehung geschaltet sind. 

Wenn der Benutzer Eingangs-Tags mit einem vorangestellten "#" projektiert 
hat, stehen ferner zusätzliche Eingänge zur Verfügung. Ebenso kann der 
Benutzer Ausgänge von der Matrix zur Planlogik verbinden, indem er Tags mit 
nachgestelltem "#" projektiert. 

Die folgende Abbildung zeigt den bei der Übertragung einer Matrix mit dem 
Namen "SM_Demo" erzeugten Plan. Der Plan zeigt den projektierten externen 
Ursacheneingang (#RESET) und den Wirkungsausgang (#ESD). Vor der 
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Übersetzung sind die externen Eingänge und Ausgänge mit der Benutzerlogik 
zu verschalten. 

 

 
 Hinweis 

Nach der Übertragung der Matrix in das Projekt kann mit Funktion 
Tools>Compare>Compare with Project geprüft werden, ob die Projektkonfiguration mit 
der Matrix übereinstimmt. 

 
 Hinweis 

Um die ordnungsgemäße Überwachungsfunktion der Safety Matrix zu gewährleisten, dürfen 
die Namen der während der Matrixübertragung erstellten Pläne nicht geändert werden. 

 

Übersetzen des SIMATIC-Projekts 
Klicken Sie auf Schaltfläche Compile im Dialogfeld Project Utilities bzw. die 
entsprechende Schaltfläche in anderen SIMATIC-Anwendungen. 

Nach der erfolgreichen Übersetzung des Projekts kann es in die Steuerung 
geladen werden. 

Laden des SIMATIC-Projekts in die Steuerung 
Klicken Sie auf Schaltfläche Download im Dialogfeld Project Utilities bzw. die 
entsprechende Schaltfläche in anderen SIMATIC-Anwendungen. Die Matrixlogik 
kann dann auf ihre einwandfreie Funktion überprüft werden. 
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5 Operation 

5.1 Ansicht einer Safety Matrix im Überwachungsbetrieb 

Der Überwachungsbetrieb im Safety Matrix Engineering Tool ermöglicht die 
Überwachung von Echtzeitwerten und die Ansicht des Status einer Matrix, die in 
die Steuerung geladen wurde.   

Starten des Überwachungsbetriebs 
Zum Starten des Überwachungsbetriebs ist Menüoption Tools>Start Monitoring 
auszuwählen.   

Das Safety Matrix Engineering Tool stellt die Verbindung zum Safety Matrix 
Funktionsbaustein in der Steuerung oder im Simulator her. Nachdem die 
Verbindung aufgebaut ist, werden aktive Ursachen und Wirkungen in Rot 
angezeigt. 
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Siehe auch 
Safety Matrix Menüoptionen mit näheren Einzelheiten zum Dialogfeld Safety Matrix 
Options.  

 



 Operation 

Safety Matrix Benutzerhandbuch 
A5E00265324-01 5-3 

5.2 Farbcodes zur Statusanzeige 

Im Überwachungsbetrieb von Safety Matrix wird der Status von Ursachen, 
Schnittpunkten und Wirkungen mit verschiedenen Farben angezeigt.  Diese 
Farben sind fest belegt und können vom Benutzer nicht geändert werden.  

Color Status

Rot Cause/Effect Active

Magenta Bypass Active or Tag Disabled

Gelb Inhibit/Mask Active

Braun Effect Override Active

Grün Safe to Reset Effect

Cyan First Out Alarm Active

Blau Klicken View Status button
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5.3 Steuerung des Systems im Überwachungsbetrieb 

Für die Arbeit mit einer Online-Matrix steht im Safety Matrix Engineering Tool die 
Steuerleiste zur Verfügung. Nachdem eine Ursache oder eine Wirkung in der 
Matrix ausgewählt ist, werden die für diese Auswahl verfügbaren 
Steuerleistenfunktionen in den Schaltflächen der Steuerleiste angezeigt.   

Welche Funktionen jeweils verwendbar sind, hängt ab von: 

• dem ausgewählten Element,  

• der Konfiguration des Elements und  

• dem Status des Elements.  

Das folgende Beispiel zeigt die Steuerleiste mit einer hervorgehobenen Ursache, 
die eine Quittierung (ACK) durch den Benutzer erfordert. 

 

 

Wird eine Funktion der Steuerleiste angefordert, so werden Sie aufgefordert, diese 
Funktion zu bestätigen, bevor der entsprechende Befehl an die Steuerung 
gesendet wird. 
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Steuerleistenfunktion Funktion 

Ack Cause Schaltfläche Ack Cause ist bereit, wenn die ausgewählte Ursache aktiv und 
nicht mit automatischem Quittieren projektiert ist.Es wird eine Alarm ACK-
Anforderung angezeigt und die Ursache bleibt aktiv, bis Schaltfläche Ack Cause 
angeklickt wird. 
 

Clear First Out Schaltfläche Clear First Out zeigt an, welche Ursache zuerst die zugehörige 
First-Out-Alarmgruppe ausgelöst hat. Diese erste Ursache wird in Cyan 
markiert, bis die Ursache und Schaltfläche Clear First Out angeklickt werden. 
 

Bypass Mit Schaltfläche Bypass wird verhindert, dass eine Ursache oder eine Wirkung 
aktiv wird.  Wird eine Ursache mit Bypass umgangen, so wird sie nicht aktiv.  
Wird eine Wirkung mit Bypass umgangen, so werden ihre Wirkungs-Tags auf 
ihre Betriebswerte gesetzt.  Zum Schalten einer Umgehungsfunktion ist ein 
Passwort erforderlich, das im Dialogfeld nach dem Anklicken von Schaltfläche 
Bypass eingegeben werden muss.  
Bevor die Umgehungsfunktion aktiviert wird, werden Sie aufgefordert, einen 
Grund für das Schalten einer Wartungsumgehung einzugeben. Die im Dialogfeld 
eingegebenen Informationen werden im Event Logger protokolliert. 

 
 

View Events Die Ereignisaufzeichnung ist eine Standardfunktionalität von Safety Matrix. Mit 
der Ereignisaufzeichnung kann die Matrix ereignisbezogene Informationen 
anhand von Zustandswechseln von Ursache und Wirkung speichern. Es werden 
maximal 200 Ereignisse unterstützt. Übersteigt die Anzahl der Ereignisse die 
Puffergröße, so werden die ältesten Ereignisse durch die jüngeren 
überschrieben. Damit ist gewährleistet, dass stets die jüngsten Ereignisse in der 
Anzeige stehen. 
Mit der Funktion View Events kann das Safety Matrix Engineering Tool 
Ereignisse aus der Steuerung lesen und im Ereignisfenster anzeigen. Siehe 
Beschreibung der Statusdetails für Ursache und Wirkung mit Informationen, 
welche Benutzerhandlungen und Diagnoseereignisse aufgezeichnet werden. 
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Steuerleistenfunktion Funktion 

Clear Events Funktion Clear Events veranlasst das Löschen des Ereignisprotokolls in der 
Steuerung durch Safety Matrix. 
 

Bypass Report Funktion Bypass Report legt eine Liste aller Ursachen und Wirkungen an, für die 
Umgehungen eingerichtet sind, und aller aktuell deaktivierten Tags. Die 
Ergebnisse werden im Log-Fenster angezeigt. Das nachstehende Beispiel zeigt 
eine Umgehung für Ursache 1 und Wirkung 4, Tag 1 "PT_101" für Ursache 7 ist 
deaktiviert. 

 
View Status Schaltfläche View Status ist verfügbar, wenn eine Ursache oder eine Wirkung 

ausgewählt ist.  Durch Klick auf diese Schaltfläche wird das Dialogfeld Cause 
Status Detail oder Effect Status Detail eingeblendet.  Diese Dialogfelder 
enthalten Informationen zu den aktuellen Einstellungen der Matrixfunktionen für 
die ausgewählte Ursache oder Wirkung. Änderungen sind in diesen 
Dialogfeldern nicht möglich.  
Ist ein Element weiß hervorgehoben, so ist es markiert oder aktiv.  Jede 
Eingabe im Dialogfeld entspricht einem Status-/Fehler-Bit für die ausgewählte 
Ursache oder Wirkung.   
Siehe Statusdetails für Ursachen und Wirkungen weiter unten. 
 

View Tags Mit Klick auf Schaltfläche View Tags wird ein Dialogfeld angezeigt, in dem die 
Werte von Ursachen- oder Wirkungs-Tags betrachtet, ein Tag in der Steuerung 
deaktiviert und Skalierbereiche für E/A-Tags angezeigt oder geändert werden 
können.  Siehe Eingabe von Wartungsänderungen weiter unten.  
 

Clear Alarm Funktion Clear Alarm wird aktiv, wenn eine Wirkung ausgewählt wurde, die mit 
Override übergangen wurde, die aber aus einem der folgende Gründe erneut 
aktiv geworden ist: 
• die projektierte maximale Override-Zeit ist abgelaufen 
• sie wurde durch eine neue aktive Ursache erneut ausgelöst.  
In diesen Fällen wird ein Alarm für die Wirkung angezeigt.  Schaltfläche Clear 
Alarm muss zum Löschen der Alarmmeldung angeklickt werden. 
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Steuerleistenfunktion Funktion 

Reset Effect/Override 
Effect 

Die Beschriftung dieser Schaltfläche ist entweder Reset Effect oder Override 
Effect je nach dem Status der gewählten Wirkung. 
 

• Reset Effect Wird eine Wirkung durch einen Schnittpunkttyp S (Set-Stored) oder R 
(Resetable/Override) ausgelöst, so wird die Wirkung verriegelt.  Das bedeutet, 
sie bleibt auch aktiv, wenn sie von der Ursache nicht mehr ausgelöst wird.  Die 
Wirkung kann freigegeben werden (Reset), wenn sie nicht mehr ausgelöst wird.  
Zur Freigabe der Wirkukng ist Reset Effect anzuklicken.  Diese Funktion steht 
nur zur Verfügung, wenn für die ausgewählte Wirkung ein Rücksetzen möglich 
ist (in den Standardfarbeinstellungen in Grün angezeigt). 
 

• Override Effect Wird eine Wirkung durch einen Schnittpunkttyp V (oVerride) oder R 
(Resetable/Override) ausgelöst, wo können die Ausgangs-Tags der Wirkung auf 
die Betriebswerte gesetzt werden, obwohl die Wirkung noch ansteht.  Dies wird 
als Override-Funktion bezeichnet.  Ist für die ausgewählte Funktion diese 
Möglichkeit vorgesehen, so kann die Override-Funktion mit dieser Schaltfläche 
aktiviert werden.  Mit Klick auf Schaltfläche Override Effect können die 
Wirkungs-Tags auf ihre Betriebswerte zurückgesetzt werden. 
Hinweis 
Die Dauer der Override-Funktion darf die unter den Optionen eingestellte 
maximale Zeit (Maximum Override Time) nicht übersteigen. 
Wird während der Override-Zeit eine andere (mit der Wirkung verschaltete) 
Ursache aktiv, so endet die Override-Funktion sofort. 
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Statusbeschreibungen Ursache 

 

 
Ursachenstatus Beschreibung Ereignis Klicken 

View 
Status 

Cause Active Zeigt an, dass alle projektierten Kriterien für den aktiven 
Zustand erfüllt sind (Status, Funktionslogik, Zeitverzögerungen 
usw.). 

X  

Timed Active Zeigt an, dass eine projektierte Zeitverzögerung aktiv ist.  Nach 
Ablauf der Zeitverzögerung wird Bit Delay Active gelöscht.  

  

Hysteresis Active Zeigt an, dass eine aktive Ursache ihre Auslösebedingung 
verlassen hat, aber immer noch innerhalb der projektierten 
Totzone ist. 

  

Inhibit Active Zeigt an, dass die Ursache durch den projektierten Sperr-Tag 
gesperrt ist. 

X  

Bypass Active Zeigt an, dass die Ursache derzeit umgangen wird. X  
Soft Bypass Active Zeigt an, dass die aktuelle Umgehung vom Safety Matrix 

Engineering Tool oder Safety Matrix Viewer gesetzt wurde. 
X  

Trip Requested Zeigt an, dass die Ursachen-Funktionslogik (UND, ODER, 
Voting) erfüllt ist. Der aktive Status der Ursache kann durch die 
projektierten Zeitverzögerungen, durch Umgehung, Sperre und 
Verriegelung beeinflusst sein. 

  

Delta Alarm (TagX – TagY) Zeigt an, dass die berechnete Tag-Differenz (X – Y) den 
projektierten Delta-Alarmwert überschritten hat. 

 X 
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Ursachenstatus Beschreibung Ereignis Klicken 
View 

Status 

Any Input Trip Alarm Bei einer Ursache mit mehreren Tags zeigt dieser Status an, 
dass mindestens ein Tag die Auslösebedingung erreicht hat 
und eine Auslösung anfordert. 

 X 

Illegal Config Error Interne Diagnoseprüfung des FB (z.B. undefinierter 
Funktionstyp). 

 X 

SDF Error Zeigt an, dass die Matrix einen SDF-Fehler (Safety Data 
Format) erkannt hat. 

 X 

Active Ack Required Zeigt an, dass die Ursache im aktiven Zustand verriegelt wird, 
bis sie vom Anwender quittiert wird und die Auslösebedingung 
verschwunden ist. 

X X 

Tag # Trip Request Zeigt an, dass der projektierte Tag die Bedingung für die 
Anforderung einer Auslösung erfüllt. Dieser Status beinhaltet 
die Energize-To-Trip-Einstellung des Tags. 

X  

Tag # Value Zeigt den projektierten Tag-Status an.   
Tag # Bad Quality Zeigt an, dass der Kanaltreiber des projektierten Tags einen 

Qualitätsalarm meldet. 
 X 

Tag # Disabled Zeigt an, dass der projektierte Tag deaktiviert wurde. X  
Tag # Channel Failure Zeigt an, dass der Kanaltreiber des projektierten Tags einen 

Kanalfehler meldet. 
 X 

Tag # ProfiSafe Failure Zeigt an, dass der Kanaltreiber des projektierten Tags einen 
Profibus-Fehler meldet, dessen Ursache der Baugruppentreiber 
ist. 

 X 
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Statusbeschreibungen Wirkung 

 

 
Wirkungsstatus Beschreibung Ereignis Klicken 

View 
Status 

Effect Active Zeigt an, dass alle projektierten Kriterien für den aktiven 
Zustand erfüllt sind (Schnittpunktstatus, Zeitverzögerungen, 
Umgehung usw.). 

X  

Delay Active Zeigt an, dass eine Zeitverzögerung aktuell aktiv ist.   
Mask Active Zeigt an, dass eine Maskierung aktuell aktiv ist. X  
Override Active Zeigt an, dass eine Override-Funktion aktuell aktiv ist. X  
N Intersections Zeigt an, dass ein verschalteter Schnittpunkttyp N aktiv ist.   
S Intersections Zeigt an, dass ein verschalteter Schnittpunkttyp S aktiv ist.   
V Intersections Zeigt an, dass ein verschalteter Schnittpunkttyp V aktiv ist.   
R Intersections Zeigt an, dass ein verschalteter Schnittpunkttyp R aktiv ist.   
Bypass Active Zeigt an, dass eine Umgehung aktuell aktiv ist. X  
Soft Bypass Active Zeigt an, dass die aktuelle Umgehung vom Safety Matrix 

Engineering Tool oder Safety Matrix Viewer gesetzt wurde. 
X  

Pass Thru Active Zeigt an, dass in der Wirkungslogik ein Prozessdurchgang aktiv 
ist. 

X  
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Wirkungsstatus Beschreibung Ereignis Klicken 
View 

Status 

Override Input Zeigt an, dass die Wirkung aktuell mit Override übergangen 
wird. 

  

Ok to Override Zeigt an, dass die Wirkung bereit zum Übergehen mit Override 
ist. 

  

Ok to Reset Zeigt an, dass die Wirkung bereit zum Rücksetzen ist.   
Effect Latched Zeigt an, dass die Wirkung verriegelt ist.   
Override Failed 
NewCause 

Zeigt an, dass das Übergehen der Wirkung mit Override 
unterbrochen wurde, weil eine neue Ursache aktiv wurde. 

 X 

Override Failed Timeout Zeigt einen Zeitfehler beim Übergehen der Wirkung mit 
Override an. 

 X 

Illegal Config Error Interne Diagnoseprüfung des FB (z.B. undefinierter 
Funktionstyp). 

 X 

SDF Error Zeigt an, dass die Matrix einen SDF-Fehler (Safety Data 
Format) erkannt hat. 

 X 

Tag # Value Zeigt den aktuellen Status des projektierten Ausgangs-Tags an.   
Tag # Bad Quality Zeigt an, dass der Kanaltreiber des projektierten Tags einen 

Qualitätsalarm meldet. 
 X 

Tag # Disabled Zeigt an, dass der Tag deaktiviert ist. X  
Tag # Channel Failure Zeigt an, dass der Kanaltreiber des projektierten Tags einen 

Kanalfehler meldet. 
 X 

Tag # ProfiSafe Failure Zeigt an, dass der Kanaltreiber des projektierten Tags einen 
Profibus-Fehler meldet, dessen Ursache der Baugruppentreiber 
ist. 

 X 
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5.4 Eingabe von Wartungsänderungen im 
Überwachungsbetrieb 

Tag deaktivieren und Werte in die Steuerung schreiben 
1. Im Dialogfeld View Tags for Cause # Kontrollkästchen Enable Maintenance 

Changes aktivieren. 

 

2. Schaltfläche Disable für den betreffenden Tag anklicken. Sie werden 
aufgefordert, einen Grund einzugeben, der mit dem Ereignis zusammen 
aufgezeichnet wird. 

 

Nach dem Deaktivieren des Tags können analoge Tags durch Eingabe einer 
REELLEN Zahl im Wertefeld und Klick auf Schaltfläche Write geändert 
werden. Der neue Wert wird an die Steuerung gesendet. Diskrete Tags können 
auf die gleiche Weise geändert werden, indem Schaltfläche TRUE oder 
FALSE angeklickt wird. 
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 Hinweis 
Zum Deaktivieren eines Tags in einer Matrix gelten die folgenden Einschränkungen: 
• Wenn der Kanaltreiber des Tags für diese Matrix projektiert wurde, betrifft die 

Deaktivierung alle Benutzer des Tags. Dazu gehören andere Matrices und jede 
benutzerprojektierte Logik. Kanaltreiber, die nicht für diese Matrix projektiert sind, sind 
mit einem vorangestellten "@" prefix im Projektierungsfeld des Tags gekennzeichnet. 

• Stammt der Kanaltreiber des Tags aus den fehlersicheren Bausteinen (V1_2), so betrifft 
die Deaktivierung nur die matrixeigenen Funktionen. Wird der Kanal mit einer 
matrixfremden Logik gemeinsam genutzt, so wird diese Logik nicht deaktiviert und 
"sieht" weiterhin den Wert des physikalischen E/A. 

Ändern der Bereichsskalierung für analoge E/A-Tags 
1. Im Dialogfeld View Tags on Cause # Schaltfläche Ranges für den Tag 

anklicken, der geändert werden soll. Dialogfeld MinScale & MaxScale Values 
zum jeweiligen E/A-Tag wird dann aufgeblendet.   

2. Kontrollkästchen Enable Maintenance Changes aktivieren, so dass die neuen 
Werte für MaxScale und MinScale eingegeben und die Skalierung des Tags 
geändert werden kann. Schaltfläche Update Values liest die aktuellen Wert in 
die Steuerung ein. 
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5.5 Änderungen im Überwachungsbetrieb 

Während eine Matrix in der Steuerung abgearbeitet wird, können Änderungen der 
projektierten Grenzwerte, Hysterese und Delta-Werte für analoge Ursachen im 
Überwachungsbetrieb vorgenommen werden.  

Parameter ändern  
1. Doppelklick auf Analog cause in Zelle Limit/Trip. Dialogfeld Perform Online 

Changes wird geöffnet.  

2. Geben Sie in Textfeld New Value den/die analogen Parameter ein, der/die 
geändert werden soll(en).  

3. Klicken Sie auf Schaltfläche OK, um die Änderungen an die Steuerung zu 
senden. 
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5.6 Beenden des Überwachungsbetriebs 

Zum Beenden des Safety Matrix Engineering Tools oder für weitere Änderungen 
der Konfiguration über die hier beschriebenen hinaus (Änderungen im 
Überwachungsbetrieb), muss die Safety Matrix im Offline-Betrieb sein.   

 Beenden des Überwachungsbetriebs 
Wählen Sie Menüoption Tools>Stop Monitoring. 
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6 Safety Matrix Menüoptionen 

Dieses Kapitel beschreibt die Menüoptionen, die im Dialogfeld des Safety Matrix 
Engineering Tools angeboten werden, und wie diese Menüoptionen zum Einrichten 
einer Safety Matrix benutzt werden. 
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6.1 Menü File 

 

 
Befehl Funktion 

New Öffnet eine leere Matrix unter dem Namen NewMatrix.cem als Read-only-Datei. Mit Save 
kann der neuen Matrix ein Dateiname zugeordnet werden. 
 

Open... Zeigt das Dialogfeld Open zur Auswahl und zum Öffnen einer zuvor projektierten Matrix. 
Mit dieser Option kann eine Matrix zum Bearbeiten geöffnet werden. 
 

Close Schließt die aktuelle Matrixdatei. Sie werden aufgefordert, Änderungen in der Matrix zu 
speichern, bevor die Datei geschlossen wird. 
 

Save Speichert die aktuelle Matrix in einer Datei. Werden Änderungen der Matrix gespeichert, 
so ersetzt die neue Matrix die ältere Version. Wird eine Matrix in einem Projekt 
überschrieben, so werden Sie aufgefordert, die Änderungsmarken zu löschen, den 
Änderungsstand anzupassen und das Passwort für das Sicherheitsprogramm 
einzugeben. Beim Speichern in einer neuen Datei ist kein Passwort erforderlich. 
 

Save As... Speichert die Matrix in einer anderen Datei. 
 

Print Preview Zeigt eine Vorschau der Log-Datei, die ausgedruckt werden soll. 
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Befehl Funktion 

Print... Öffnet das Dialogfeld Print. Im Dialogfeld Print kann der Ausdruck der aktuellen Matrix in 
ihrer graphischen Darstellung oder eine Druckvorschau der Matrix veranlasst werden. 
Befehl Print steht nur im Offline-Betrieb zur Verfügung.   
 

Exit Schließt alle Dialogfelder und beendet das Programm. Befehl Exit steht nur im Offline-
Betrieb zur Verfügung. 
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6.2 Menü Edit 

 

 
Befehl Funktion 

Cleanup Matrix Erzwingt eine neue Zeichnung der aktuellen Matrix. Mit dieser Funktion kann die 
Zellenbreite der Ursache- und Wirkungszellen anhand der längsten eingegebenen 
Zeichenketten in der Größe angepasst werden.  
 

Clear Matrix Entfernt alle Elemente aus der aktuellen Matrix. 
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6.3 Menü View 

 

Befehl Funktion 

General Information ... Öffnet das Dialogfeld General Information, in dem Details zur Matrix 
eingegeben werden können. 
 

Options... Öffnet das Dialogfeld Matrix Options.  In diesem Dialogfeld kann ausgewählt 
werden, welche Informationen zur Matrix angezeigt werden.  Ferner kann hier 
die Anzahl der Ursachen und Wirkungen der Matrix geändert werden. 
 

Log Öffnet das Log-Fenster, in dem Safety Matrix Informationen zu den vom 
Benutzer angestoßenen Vorgängen angezeigt werden (z.B. Übertragen, 
Übersetzen und Laden). Diese Informationen werden jeweils von den 
aktuellsten Vorgängen überschrieben; sollen sie aufbewahrt werden, so kann 
die Log-Datei mit Befehl File>Log Save As gespeichert werden. 

Allgemeines 
Siehe Abschnitt  Bearbeiten allgemeiner Informationen im Kapitel Projektierung.  
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View>Optionen 

 

 
Feld Beschreibung 

Matrix Size  
Number of Causes Standardmäßig sind hier 16 Ursachen eingetragen, diese Zahl 

kann bis auf 128 erhöht werden.  
 

Number of Effects Standardmäßig sind hier 16 Wirkungen eingetragen, diese Zahl 
kann bis auf 128 erhöht werden. 
 

Show C/E Options Zeigt die für die Ursache (C) oder Wirkung (E) in der 
Sicherheitsmatrix eingestellten Optionen.  Die folgende Liste 
enthält die Abkürzungen, die in diesem Feld stehen können. Diese 
Liste wird auch unten rechts in der Matrix angezeigt. 
I – Sperre konfiguriert 
M – Maske konfiguriert 
B – Umgehung für Wartung 
N – Nicht-standardmäßiger E/A benutzt (kein E/A-Tag) 
P – Prozessdatendurchgang benutzt 
A – Automatische Ursachenquittierung benutzt. 
 

Show C/E Notes Zeigt die Nummern der Anmerkungen, die dieser Ursache bzw. 
dieser Wirkung zugeordnet sind.  Die den Nummern 
entsprechenden Anmerkungen sind auf der rechten Seite der 
Matrix aufgeführt. 
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Feld Beschreibung 

Show C/E SIL Zeigt die SIL-Nummer (Safety Integrity Level), die dieser Ursache 
bzw. dieser Wirkung zugeordnet ist. 
 

Show Safety/First Out Groups Zeigt die First-Out- und/oder Sicherheitsgruppen, denen diese 
Ursache bzw. diese Wirkung zugeordnet ist.  Die First-Out-Gruppe 
ist mit der Abkürzung "FO" gekennzeichnet.  FO2 zeigt zum 
Beispiel an, dass die Ursache zur First-Out-Gruppe (FO) 2 gehört.  
Die Nummern der Sicherheitsgruppen erscheinen hinter der First-
Out-Nummer.  Beispiel: FO3, 5, 17, 44 zeigt an, dass diese 
Ursache zur First-Out-Gruppe (FO) 3 und den Sicherheitsgruppen 
5, 17 und 44 gehört. 
 

Show Reset/Override Tag Zeigt den Rücksetz-/Override-Tag, der der Wirkung zugeordnet ist.
 

Show IO Physical Address in View 
Tags 

Zeigt die physikalische E/A-Adresse zusammen mit der 
Symbolreferenz im Dialogfeld View Tags. 
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6.4 Menü Tools 

 

 
Befehl Funktion 

Start/Stop Monitoring Schaltet den Überwachungsbetrieb ein und aus. 
 

CPU Module Information... Zeigt Informationen zur SPS wie in anderen SIMATIC-Anwendungen. 
 

CPU Operating Mode... Zeigt die Betriebsart der SPS wie in anderen SIMATIC-Anwendungen. 
 

Project Utilities... Öffnet den Dialog Project Utilities, in dem die Funktionen Übertragen, 
Übersetzen und Laden möglich sind. Nähere Einzelheiten enthält Kapitel 
Projektierung. 
 

Compare Erzeugt einen Vergleich der aktuell geöffneten Matrix  mit einem der 
folgenden Elemente. 
 

• Compare with Matrix  Vergleicht die aktuelle Matrix mit einer anderen, aktuell geöffneten Matrix. 
 

• Compare with Saved Vergleicht die aktuelle Matrix mit der zuletzt gespeicherten Version der 
Matrix. 
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Befehl Funktion 

• Compare with Project Vergleicht die aktuelle Matrix mit der zuletzt an das Projekt übertragenen 
Matrix. 
 

• Compare with PLC Vergleicht die aktuelle Matrix mit der in das AS übertragenen und 
übersetzten Matrix. 
 

Configuration Report Erzeugt einen Bericht mit der kompletten Matrixkonfiguration im Log-
Fenster. 
 

Validation Report Startet eine Konfigurationsprüfung der Matrix und zeigt die Ergebnisse im 
Log-Fenster.  
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6.5 Menü Window 

 

 
Befehl Funktion 

Tile Horizontal Ist mehr als ein Fenster geöffnet, werden mit diesem Befehl die 
Fensterausschnitte nebeneinander angeordnet. 
 

Tile Vertical Ist mehr als ein Fenster geöffnet, werden mit diesem Befehl die 
Fensterausschnitte übereinander angeordnet. 
 

Cascade Ist mehr als ein Fenster geöffnet, werden mit diesem Befehl die 
Fensterausschnitte in Kaskadenform angeordnet. 
 

Arrange Icons Ordnet alle verkleinerten Matrices unten im Safety Matrix Fenster an. 
 

Opened Matrix List Zeigt eine Liste aller aktuell geöffneten Matrices im unteren Teil des Menüs. 
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6.6 Menü Help 

 

Befehl Funktion 

Help on Safety Matrix Zeigt die Hilfedatei zu Safety Matrix. 
 

About Safety Matrix Zeigt den Hilfedialog mit der aktuell installierten Version des Safety Matrix 
Engineering Tools. 
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7 Importieren einer Matrix-Datei 

Beim Anlegen und Überarbeiten von Matrices kann es erforderlich sein, die 
entwickelte Matrixlogik aus einem SIMATIC-Projekt herauszunehmen und in das 
Programm einzufügen. Dies wird als das 'Importieren einer Matrix' bezeichnet.  

Ein Beispiel ist etwa eine generische Ursachen-Wirkungs-Matrix für eine 
Notabschaltung, die in einer unternehmensinternen Forschungs- und 
Entwicklungsabteilung entwickelt wurde und in einer Reihe verschiedener 
Standorte zur Einbindung in ein lokales Projekt installiert werden soll. 

Für die Installation käme die Matrix in Form einer Matrix *.CEM-Datei. Die Datei 
enthält die gesamten Konfigurationsdaten für jeweils eine Matrix. 

Zum Importieren der Matrix in ein SIMATIC-Projekt ist folgendermaßen 
vorzugehen: 

1. Starten Sie den SIMATIC Manger. 

2. Öffnen Sie das Projekt, in das die Matrix importiert werden soll. 

3. Öffnen Sie den Matrices>Object Properties 
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4. Markieren Sie Import CEM File(s). 

 

5. Doppelklick auf die gewünschte CEM-Datei.  
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6. Bearbeiten Sie ggf. die Matrix und gehen Sie zum Übertragen, Übersetzen und 
Laden so vor wie im Kapitel Konfiguration beschrieben.  

 



Importieren einer Matrix-Datei 

 Safety Matrix Benutzerhandbuch 
7-4 A5E00265324-01 

 



 

Safety Matrix Benutzerhandbuch 
A5E00265324-01 8-1 

8 Safety Matrix Viewer 

8.1 Voraussetzungen für Safety Matrix Viewer  

Annahmen 
• Eine Safety Matrix wurde erstellt und im SIMATIC Manager an ein Projekt 

übertragen.  

• Die Safety Matrix ist in einen CFC übertragen. 

• Das Safety Matrix Projekt in SIMATIC Manager enthält bereits ein WinCC-
Projekt mit einer feststehenden Hierarchie von Anlagebereichen. 

• In Hilfedatei und Benutzerhandbuch zu Safety Matrix wird vorausgesetzt, dass 
der Benutzer die Grundlagen der WinCC-Konfiguration kennt. Mehr 
Informationen zu WinCC sind den folgenden Handbüchern zu entnehmen: 

- WinCC Information System 

- PCS7 Operator Station Konfigurationshandbuch 

Vorbereitung in WinCC für das Anlegen von Safety Matrix Bausteinsymbolen 
 

Zum Einrichten des Safety Matrix Viewer im SIMATIC Manager müssen die 
Bausteinsymbole für Safety Matrix Viewer in WinCC Pictures automatisch angelegt 
werden. Um zu gewährleisten, dass diese Funktion ordnungsgemäß abläuft, sind 
die folgenden Schritte auszuführen: 
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1. Starten Sie den WinCC Explorer für das im Safety Matrix Projekt enthaltene 
OS.  Suchen und öffnen Sie die folgenden Dateien im Graphics Designer:  
@@SafetyMatrixTypicals.PDL und @PCS7Typicals.PDL.   

Ist @PCS7Typicals.PDL noch nicht vorhanden, erstellen Sie die Datei durch 
Kopieren und Umbenennen von @@PCS7Typicals.PDL im gleichen 
Zielverzeichnis. 
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2. Kopieren Sie den Inhalt von @@SafetyMatrixTypicals.PDL an einen leeren 
Platz in @PCS7Typicals.PDL.  Beachten Sie, dass das Bausteinsymbol 
F_Matctl beim Kopieren automatisch umbenannt wird.  Im folgenden Bild ist 
das Bausteinsymbol umbenannt in "F_Matcl1". 
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3. Ändern Sie den Objektnamen des Bausteinsymbols in @PCS7Typicals.PDL zu 
@F_Matctl/1.  Klicken Sie hierfür mit der rechten Maustaste auf das Symbol 
F_Matctl Block im Bild und wählen Sie Eigenschaften.  Ändern Sie im 
Eigenschaften-Dialog das Attribut Objektname. 

 

4. Speichern Sie @PCS7Typicals.PDL und schließen Sie die Datei. 

5. Öffnen Sie @PCS7Typicals.PDL im Verzeichnis 
\SIEMENS\WINCC\options\pdl\FaceplateDesigner_V6.  Wiederholen Sie 
Schritte 1, 2, 3 und 4, erstellen Sie eine Instanz des F_Matctl Bausteinsymbols 
in dieser PDL-Instanz und benennen Sie sie um.  Ist dies richtig erfolgt, so 
enthält Datei @PCS7Typcials.PDL beim Erstellen künftiger OS-Projekte das 
F_Matctl Bausteinsymbol. 
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8.2 Projektieren des Safety Matrix Viewer 

Der Safety Matrix Viewer ist als WinCC-Faceplate in der PCS 7 OS-Umgebung 
vorhanden.  Während der Laufzeit ermöglicht das Faceplate dem Bediener das 
Lesen und die Anzeige von Datenwerten aus einer laufenden Safety Matrix in 
einem graphischen Format (ähnlich wie im Überwachungsbetrieb, der mit dem 
Safety Matrix Engineering Tool einschaltbar ist).  Verfügt der Bediener über die 
erforderliche Sicherheitsberechtigung, so kann er in der Matrix einige 
Basisfunktionen wie z.B. Ändern analoger Abgleichwerte, Projektieren von 
Umgehungs-, Rücksetz- und Override-Funktionen ausführen. 

 Projektieren des Safety Matrix Viewer 
1. Öffnen Sie das Projekt im SIMATIC Manager. 

2. Gehen Sie in Ordner Pläne in Komponentenansicht zum CFC-Plan der 
Matrix. 

3. Schneiden Sie den CFC-Plan der Matrix in Komponentenansicht aus und 
fügen Sie ihn in einen übergeordneten Ordner in Technologische Sicht ein. 
Nach dem Einfügen des CFC-Plans in Plant View erscheint er in 
Komponentenansicht und in Technologische Sicht.   

 

4. Legen Sie im übergeordneten Ordner ein Bild an, das den CFC-Plan zur Matrix 
enthält. In Technologische Sicht klicken Sie mit der rechten Maustaste auf 
den übergeordneten Ordner und wählen Sie Neues Objekt einfügen>Bild. 
Ordnen Sie dem Bild einen logischen Namen zu.   

5. Durch Klick mit der rechten Maustaste auf das Bild öffnen Sie das Dialogfeld 
Objekteigenschaften. In Registerkarte Bausteinsymbole markieren Sie 
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Option:  Derive the block symbols from the technological hierarchy. 
Schließen Sie das Dialogfeld. 

 

6. Starten Sie die OS-Übersetzung im SIMATIC Manager mit 
Optionen>OS>Übersetzen.  Aktivieren Sie mindestens die folgenden 
Übersetzungsoptionen:   

• Variablen und Meldungen 

• Picture Tree 

• Anlegen/Aktualisieren von Bausteinsymbolen 

7. Starten Sie Safety Matrix durch Doppelklick auf das betreffende Objekt im 
Ordner Matrix .   

8. Öffnen Sie Dialogfeld Project Utilities durch Auswahl von Tools>Project 
Utilities.  Klicken Sie auf Schaltfläche Map OS Tags zum Starten des Safety 
Matrix OS Mapper.  Schließen Sie das Dialogfeld, wenn der Mapper beendet 
ist. 

Diese Anweisungen gelten für PCs, die sowohl Client als auch Server sind.   
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8.3 Arbeiten mit dem Safety Matrix Viewer 

Während der Laufzeit kann der Bediener den Safety Matrix Viewer aus WinCC 
heraus starten.  Der Safety Matrix Viewer bietet eine visuelle Darstellung der 
Matrix, so wie sie im Safety Matrix Engineering Tool projektiert ist und überwacht 
wird.   Die Farbcodierung im Safety Matrix Viewer ist die gleiche wie im 
Überwachungsbetrieb des Safety Matrix Engineering Tool.  Zu beachten ist jedoch, 
dass der Safety Matrix Viewer zwar die gesamte Konfiguration einer Matrix 
anzeigen kann (mit Ursachen, Wirkungen und Schnittpunkten), die Konfiguration 
aber nicht geändert werden kann. 

 
 Hinweis 

Im Safety Matrix Viewer stehen dem Benutzer die gleichen Matrixfunktionen wie im 
Überwachungsmodus des Safety Matrix Engineering Tools zur Verfügung, mit der folgenden 
Ausnahme: 

- Bypass Report (Übersicht der aktiven Umgehungen). 
Ausführlichere Informationen sind den folgenden Abschnitten in Kapitel "BETRIEB" zu 
entnehmen:  

- Farbcodes zur Statusanzeige  
- Steuerung des Systems im Überwachungsbetrieb  
- Eingabe von Wartungsänderungen im Überwachungsbetrieb  
- Änderungen im Überwachungsbetrieb  

 

Der Safety Matrix Viewer ermöglicht die gleichzeitige Anzeige und Aktualisierung 
mehrerer Matrices. Außerdem unterstützt der Safety Matrix Viewer die gleichzeitige 
Überwachung einer Matrix auf mehreren Client-Stationen.   

Öffnen des Safety Matrix Viewer im Runtime-Modus 
1. Starten Sie den WinCC Explorer für das im Safety Matrix Projekt enthaltene 

OS.   

2. Klicken Sie auf Schaltfläche Aktivieren in der Werkzeugleiste des WinCC 
Explorers zum Starten des OS im Runtime-Modus.  



Safety Matrix Viewer 

 Safety Matrix Benutzerhandbuch 
8-8 A5E00265324-01 

3. In WinCC Runtime öffnen Sie das Bild mit dem Symbol des Safety Matrix 
Viewer und den zugehörigen E/A-Kanaltreibersymbolen (sofern eingerichtet).   

 

4. Das Symbol des Safety Matrix Viewer enthält die folgenden Daten: 

• den Safety Matrix Tag-Namen 

• die Anzahl der Ursachen-Umgehungen 

• die Anzahl der Wirkungs-Umgehungen 

• Angabe jeder aktiven Ursache 

• Angabe jeder aktiven Wirkung 

• Angabe von Alarmen 
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5. Mit Klick auf das Safety Matrix Viewer Symbol das Faceplate starten. 
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8.4 Sicherheitshinweise zum Safety Matrix Viewer 

Der Safety Matrix Viewer nutzt das WinCC Sicherheitskonzept für die Zuordnung 
der Zugangsberechtigungen für die Matrix-Steuerung zu den OS-Benutzern (z.B. 
Umgehen von Ursachen usw.).  Die Matrix-Steuerungsfunktionen funktionieren auf 
die gleiche Weise wie im Überwachungsbetrieb des Safety Matrix Engineering 
Tools. 

 
Matrix Steuerungs 

funktionen 
Keine Ebene 5 oder 

Ebene 6  
Sicherheitsberechtig

ungen 

Ebene 5  
Sicherheitsberechtig

ungen 

Ebene 6  
Sicherheitsberechtig

ungen 

Ereignisse anzeigen X X X 
Ursachen-Tags anzeigen X X X 
Wirkungs-Tags anzeigen X X X 

Ursachen-Status anzeigen X X X 
Wirkungs-Status anzeigen X X X 

Ursache quittieren  X X 
Ursache umgehen  X X 

Alarm löschen  X X 
Ereignisse löschen  X X 

Wirkung mit Override übergehen  X X 
Wirkung zurücksetzen  X X 

Ursachen-Tag ausschalten 
(Wartungsänderungen) 

 X X 

Wirkung umgehen   X 
Analoge Ursache ändern 

Grenzwerte und Hysterese 
  X 

Wirkungs-Tag deaktivieren 
(Wartungsänderungen) 

  X 
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9 Safety Matrix Editor 

Der Safety Matrix Editor ist eine Teileinheit des Safety Matrix Engineering Tools. 
Seine Funktionalität ist auf das Projektieren einer Matrix außerhalb der SIMATIC-
Umgebung beschränkt. Der Safety Matrix Editor soll die Überprüfung der 
Ursachen- und Wirkungslogik in entfernten Workstations unterstützen. 

Beispielsweise kann damit ein Techniker an einer Workstation mit dem Safety 
Matrix Engineering Tool die Anfangsversion einer Safety Matrix erstellen. Die Logik 
der Matrix kann gespeichert und für die lokale Überarbeitung über das Netzwerk 
gemeinsam genutzt oder als e-mail an Kollegen in der ganzen Welt verschickt 
werden. Mit dem Safety Matrix Editor kann der Bearbeiter die Matrix öffnen und im 
gleichen Format wie der Ersteller betrachten. Der Bearbeiter kann die 
Matrixkonfiguration ändern (z.B. Funktionstypen ändern, Parameter verändern, 
Änderungsvermerke einfügen usw.) und speichern. Eine Matrix kann auch aus 
dem Safety Matrix Editor hervorgehen. 

In jedem Fall kann die Matrix an einen Techniker, der mit dem Safety Matrix 
Engineering Tool arbeitet, für die Einbindung in ein SIMATIC-Projekt verschickt 
werden. 

Die folgenden Funktionen des Safety Matrix Engineering Tools sind im Safety 
Matrix Editor nicht vorhanden: 

1. Matrix Project Utilities 

- Transfer to Project 

- Compile 

- Download 

- Map OS Tags 

2. CPU Information 

- CPU Module Information 

- CPU Operating Mode 

3. Matrix Compare Functions with SIMATIC 

- Compare with Project  

- Compare with PLC 

Den Safety Matrix Editor öffnen 
Menüoptionen Start>Programme>Siemens>SafetyMatrix wählen. 

Anlegen einer neuen Matrix 
Menüoption File>New wählen. 
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Es wird ein Dialogfeld eingeblendet, in dem Sie aufgefordert werden, einen Namen 
für die neue Matrix einzugeben. 

Standardmäßig wird die neue Matrix im Verzeichnis Safety Matrix 
(C:\Siemens\SafetyMatrix) abgelegt. Sie können aber auch einen anderen 
Speicherplatz wählen. 

Eine vorhandene Matrixdatei öffnen 
Wählen Sie File>Open 

Gehen Sie zu der gewünschten Matrixdatei. 

Markieren Sie die Datei und öffnen Sie sie. 

Eine Matrix bearbeiten 
Nach dem Öffnen einer Matrix zur Berabeitung funktioniert das Projektieren im 
Safety Matrix Editor auf die gleiche Weise wie im Safety Matrix Engineering Tool. 
Siehe Kapitel Projektierung mit näheren Einzelheiten. 

Eine Matrixdatei gemeinsam nutzen 
Sind Sie mit der Ursachen- und Wirkungslogik zufrieden, dann speichern und 
schließen Sie die Matrix. 

Die Matrix ist vollständig in der Matrixdatei (*.cem) enthalten. Sie kann wie jede 
beliebige Datei mit den bekannten Systemfunktionen verschoben, kopiert usw. 
werden. Die *.CEM-Datei ist von einem gemeinsam genutzten Standort aus 
zugänglich oder kann an andere Benutzer per e-mail verschickt werden. 
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10 Detail-Funktionsschaubilder 

Die Detail-Funktionsschaubilder zu Ursachen und Wirkungen stellen den 
Funktionsablauf für die jeweiligen Konfigurationseinstellungen der Ursachen und 
Wirkungen dar.  Anhand dieser Schaubilder kann die Ursachen-Wirkungs-
Verknüpfung in verschiedenen Konfigurationen vorausschauend geplant werden. 

Detail-Funktionsschaubild Ursache 

Maintenance Tag
Disable

Input Tag 1

Input Tag 2

Input Tag 3

Energize to Trip or
Deenergize to Trip

Signal
Polarity

Signal
Polarity

Signal
Polarity

Analog
 Limit

High/Low &
Deadband

Delta Delta
Alarm

Tag X
Quality
Check

Cause Function

Majority Voter
ANDing
ORing

Check
For
Trip

Function Type
AND, OR, Vote

OR

AND

Delay
Timed

Function

Timed Cause or
Pre Trip Delay or
Post Trip Delay
Duration Time (sec)

Trip
Requested

Inhibit
Function

Inhibit Allowed
Inhibit Tag

Analog Type

Discrete Type

Delta Check
|T1-T2|, |T1-T3|, |T2-T3|

Any Trip
Requested

Cause Not Active

2 or 3 Inputs

ORAND

Input X Quality Alarm

Trip On Diagnostics

Tag X Error

Tag X Discrete

Tag X Quality Check

User Entered
Configuration Information

Indicates Physical I/O or
Tagged Accessable Data

Soft Bypass
Allowed

Hardware
Bypass Tag

Security

Safety Matrix Tool
Add or Remove
Soft Bypass

Hardware Bypass
Tag Value

(TRUE = Bypass)

Security

Cause
Active

Diagnostic AlarmAND
Enable Any
Trip Alarm

Trip On
Diagnostics

Quality
Alarms

Bypass
Function

Hardware Inhibit
Tag Value

(TRUE = Inhibit)

Latch
Cause

Auto
Acknowledge
Active Cause

Safety Matrix Tool
Ack Active Cause
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Detail-Funktionsschaubild Wirkung 

Effect
Latch

Reset/Override Tag
Max Override Time

Trip
RequestedOR

Latch Effect

AND

AND

OK to Reset

OK to
Override

Security

Any Override
Intersection Active

New Cause Active

From Intersections

Override
 Failed

Effect
Latched

Effect
Active

Delay
Outputs
Function

Delay Enabled
Delay Time (sec)

Soft Bypass Allowed
Hardware Bypass Tag

Security

Safety Matrix Tool
Add or Remove

Soft Bypass

Reset/Override Data Value
Defined by Reset/Override Tag

Pass Through
Allowed

Mask Allowed
MaskEnable Tag
ProcessData Tag

Mask
Function

Process Data Value
Pointed to by the
ProcessData Tag

Hardware Bypass
Tag Value

(TRUE = Bypass)

Bypass
Function

Security

Mask Enable Data Value
Pointed to by the
MaskEnable Tag

Energize To Trip

Invert
Signal

Maintenance
Tag Disable

Output Tag 1

Output Tag 2

Output Tag 3

Output Tag 4

User Entered
Configuration Information

Indicates Physical I/O or
Tagged Accessable Data

False to True
Starts Override or

Resets Effect

Any ResetOverride
Intersection Active

Any Set
Intersection Active

Any Normal
Intersection Active

OR

In-Active

Failsafe
Outputs

Bypass
Active

Process
Pass Through

Function

PassThrough
Active

Mask
Active

Invert
Signal

Invert
Signal

Invert
Signal
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11 Migration einer Matrix von QUADLOG nach 
S7 F Systems 

In der SIMATIC-Umgebung werden alle Matrices als *.CEM-Dateien gespeichert.  

In der QUADLOG Safety Matrix werden die Matrices entweder als *.CEM-Dateien 
gespeichert oder als *.XLS-Dateien exportiert.  

Mit dem Safety Matrix Engineering Tool können die Matrices sowohl im SIMATIC- 
als auch im QUADLOG-Format geöffnet werden, so dass die Migration problemlos 
ist. 

Migration einer QUADLOG-Matrix 
1. Wählen Sie Datei>Öffnen 

2. Gehen Sie zur gewünschten QUALOG *.CEM- oder *.XLS-Datei und 
markieren Sie sie. 

3. Klicken Sie auf Öffnen 

Die Datei wird geöffnet und Sie werden aufgefordert, einen Namen einzugeben, 
unter dem die Datei nach der Migration gespeichert wird.  

Nach der Migration wird automatisch ein Überprüfungsbericht für die Datei 
ausgeführt. Einige QUADLOG-Matrixfunktionen werden derzeit in der SIMATIC 
Safety Matrix für S7 F Systems nicht unterstützt. Diese Funktionen und wie mit 
ihnen umzugehen ist sind nachstehend aufgeführt: 

• Ursache - Differenztyp wird mit 'Note Only' projektiert. 

• Wirkung – Einzelanalogausgänge werden mit 'Note Only' projektiert. 

• Wirkung – Kontrollausgänge werden mit 'Note Only' projektiert. 

• Global Var Tag I/O – Vorangestelltes Zeichen "#", wird im Matrixplan als 
Eingang oder Ausgang festgelegt. 

Die Datei kann dann in ein SIMATIC-Projekt importiert und die Konfiguration je 
nach Wunsch geändert werden. 
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12 Glossar 

 
Begriff Definition 

Umgehen Verhindert, dass eine Ursache oder eine Wirkung aktiv wird.  Wird eine 
Ursache umgangen, so kann sie keine Wirkungen auslösen.  Wird eine 
Wirkung umgangen, so werden ihre Wirkungs-Tags auf ihre Betriebswerte 
gesetzt. 
 

Ursache Ein oder mehrere Tags, deren Zustandsverknüpfungen festlegen, ob eine 
Ursache aktiv oder inaktiv ist. 
 

Ursachenstatus Der Status ist entweder aktiv oder inaktiv.  Der Status einer Ursache wird 
durch die Bedingung(en) des/der Ursachen-Tags und den Funktionstyp (z.B. 
Mehrheitsverfahren, UND, ODER) der Ursache bestimmt. 
 

Ursachen-Tag Ein bestimmter Tag (E/A-Tag oder globale Variable) in einer Ursache. 
 

CFC Continuous Function Chart 
1.  Continuous Function Chart  (CFC) mit der graphischen Verschaltung 
technologischer Funktionen (Bausteine). 
2.  Softwarepaket (CFC-Editor) wird die anlagenorientierte graphische 
Projektierung eines Automatisierungsprojekts.  Mit CFC können fertige 
Bausteine zu einer kompletten Softwarestruktur (CFC-Plan) zusammengestellt 
werden.  
 

Wirkung Eine Wirkung belegt eine Spalte der Matrix. Dieses Feld entspricht einer 
Prozesshandlung.  Ist die Wirkung aktiv, so werden die Wirkungs-Tags auf 
ihre fehlersicheren Werte gesetzt. 
 

Wirkung mit Override 
übergehen 

Damit werden zeitweise die Wirkungsausgänge auf ihre Betriebswerte 
gesetzt, während die zugehörige Ursache immer noch aktiv ist.  
 

Wirkung zurücksetzen Damit wird eine verriegelte Wirkung wieder freigeschaltet.  
 

Wirkungsstatus Der Status ist entweder aktiv oder inaktiv.  Ist eine Wirkung aktiv, so werden 
ihr(e) Tag(s) auf ihren fehlersicheren Werten gehalten.  Ist eine Wirkung 
inaktiv, so können ihr(e) Tag(s) die Betriebswerte annehmen. 
 

Wirkungs-Tag Ein bestimmter Tag (E/A-Tag oder globale Variable) in einer Wirkung. 
 

First Out Alarm Group Konzept, das die Zuordnung einer Ursache zu einer Gruppe unterstützt, um 
anzuzeigen, welche zuerst aktiv geworden ist.  
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Begriff Definition 

Fehlersicherer Wert Der Wert, der durch Schreiben in den Ausgangs-Tag den Prozess in einen 
sicheren Zustand setzt, wenn eine Wirkung aktiv ist. 
 

Sperre Sperren haben eine ähnliche Funktion wie das Umgehen, werden jedoch 
durch die Prozesslogik angesteuert.  
 

Schnittpunkt Ein Schnittpunkt ist die gemeinsame Zelle zwischen einer Ursachenzeile und 
einer Wirkungsspalte. Dieses Feld legt fest, wie die Wirkung zur Ursache in 
Beziehung steht.  Ist das Schnittpunktfeld leer, so beeinflusst die Ursache die 
Wirkung nicht.  Steht ein N (not stored), S (set stored), V (override) oder R 
(resetable Override) im Schnittpunkt, so verursacht eine aktive Ursache die 
zugehörige Wirkung und die Wirkung wird aktiv. 
 

Maskieren Diese Funktion ermöglicht die Weiterleitung eines Prozesswertes zu den 
Wirkungs-Tags unabhängig davon, ob die Wirkung aktiv ist. 
 

Betriebswert Wert, den ein Ausgangs-Tag während des normalen Betriebs annimmt. 
 

Prozessdurchgang Diese Funktion ermöglicht die Weiterleitung eines Prozesswertes zu den 
Wirkungs-Tags, während die Wirkung nicht aktiv ist.  
 

Sichere Bedingung Bedingung, die vorliegt, wenn ein Ursachen-Tag seinen normalen 
Betriebswert annimmt bzw. innerhalb seines normalen Betriebswertebereichs 
ist. 
 

Safety Instrumented 
Function (SIF) 
Gruppierung 
 

Konzept, das die Gruppierung von Ursachen und/oder Wirkungen zur 
Filterung der Anzeige unterstützt.  Für SIF-Gruppen kann die Anzeige so 
konfiguriert werden, dass nur bestimmte Ursachen und Wirkungen gezeigt 
werden.  
 

Sicherheitsgruppe Gruppe zusammengehöriger Ursachen und Wirkungen.  Eine Gruppe ist 
typischerweise einer einzigen Sicherheitsschleife zugeordnet, die aus Gebern, 
der Steuerung und Schaltelementen besteht, die eine bestimmte 
Sicherheitsfunktion ausführen. 
 

Ausgelöst-Bedingung Bedingung, die vorliegt, wenn einer Wirkung mindestens eine aktive Ursache 
zugeordnet ist. 
 

Unsichere Bedingung 
(Auslösebedingung) 

Bedingung, die vorliegt, wenn ein Ursachen-Tag nicht seinen normalen 
Betriebswert hat bzw. außerhalb seines normalen Betriebswertebereichs ist. 
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